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IMPORTANT: Avid periodically makes software updates and Customer Patch 
Releases (CPR) available for download on Avid.com at the following location:

www.avid.com/support/d ownloadcenter/index.asp

Please check the above site regularly for information on available downloads for 
your product.

Important Information

Avid recommends that you read all the information in this ReadMe file thoroughly before 
using any new software version.

This document describes hardware and software requirements and provides any special 
notes that Avid feels are important for you to know. This document also lists known 
problems and limitations.

Latest ReadMe

Information might be added after this ReadMe is complete. For the most up-to-date 
ReadMe, check the Avid Customer Support Knowledge Base at 
http://www.avid.com/readme.
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ReadMe
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Changed in v1.8.4

Avid Interplay Support

The Windows version of the editing application has been qualified in an Avid Interplay™ 
1.2.4 environment. 

Fixed in v1.8.4

The following have been fixed in this release:

➤ Previously, when you checked out a sequence or imported an AAF composition containing 
an alpha or matte key that was created in an x.7.2 editor, you might have received an error 
message. The Matte Key was offline or unusable. This has been fixed.

➤ Previously, if you were the owner of a private folder with inherited private rights set and you 
tried to check-in material into that folder, a check-in error message displayed. However, the 
material was checked in as expected. This has been fixed. The check-in error message no 
longer appears.

➤ Previously, when you sent a sequence which contained a group clip from Pro Tools back to 
Avid Interplay you would receive an “Export Selected Tracks to Sequence in Avid Interplay 
failed” error message. This has been fixed.

➤ When loading a progressive master clip into an interlace project, you will be prompted to 
perform a transcode. If you try to perform the transcode, you will receive a message 
indicating the “Transcode cannot be completed because the source contains an unsupported 
resolution.” This is as designed. The editing application does not support transcoding from 
progressive to interlaced material.

➤ Previously, you might have received an error when transcoding clips from OMF to MXF 
with no change in resolution. This has been fixed.

➤  Previously, the source timecode might have shifted when performing an edit while capture. 
This has been fixed. 

➤ Previously, when performing a multi resolution ingest, parameters such as Tape name, 
Duration, and Tracks, might have changed. This caused problems with transferring clips 
between sites and archiving. This has been fixed. 

➤ Previously, if an Airspeed within your Avid Interplay environment was out of service, a 
Send to Playback in Assist was extremely slow. This has been fixed. 
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➤ Previously, the Pan & Zoom effect used drive letters when accessing the image to be used for 
the effect. This does not work in a collaborative environment because the drive is only valid 
on the system that created the effect. UNC paths are now used.

➤ Previously, performing a sift on items in a bin was much slower on editing applications in an 
Interplay environment than editing applications in a non workgroup environment. This has 
been fixed.

➤ Previously, when logged in using a non-Administrator account, a capture or digital cut might 
not have been frame accurate on the Symphony Nitris. This has been fixed. 

➤ Previously, HD-SDI embedded audio output might have sounded distorted on some audio 
devices. This has been fixed. 

➤ Previously, while working with an Edit While Capture clip, locator text or modifications to 
locators made in Assist may not have been available to the editing application. This has been 
fixed.

➤ Previously, HD-SDI embedded audio was not being output to the Panasonic AJ-HD1700 
successfully. This has been fixed. 

➤ Previously, when you selected Render IN to OUT, not all the effects might have been 
rendered. This has been fixed.

➤ Previously, when the editing application was indexing files, in a non Avid Interplay 
environment, you would receive out of memory errors. This has been fixed. 
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Fixed in v1.8.3

Avid Interplay Support

The Windows version of the editing application has been qualified in an Avid Interplay™ 
1.2.3 environment. 

QuickTime Support

Avid qualified QuickTime® 7.3 with v1.8.3 of the Symphony Nitris editing application.

The following have been fixed in this release:

➤ Sound TC was counting at 24fps as opposed to 30fps in 1080p23 projects, causing the 
Sound TC information to drop out before the end of the clip. This has been fixed.

➤ Previously importing or capturing new clips in local bin into Avid Interplay did not update 
auto-reservation time. 

➤ Previously, you might have received a “FatalAbortAssertion failed” error when loading 
master clips with Pan/Volume changes with Dynamic Relink enabled. This has been fixed.

➤ Effects that were nested inside a submaster effect might have appeared as black instead of 
letting the lower video layers show through. This has been fixed.

➤ Previously after opening, closing, or saving a bin, the system might hang. “Not responding” 
would appear in the title bar. This has been fixed.

➤ Previously, locators placed on a title track did not reappear after the original title media was 
deleted and then title media was recreated.

➤ Previously, if you used the Audio Mixer tool to change gain and or pan, and then checked 
the clip into Avid Interplay, when you checked the clip out on another editor, the changes to 
gain or pan were lost. This has been fixed. 

➤ When checking in XDCAM proxy media into Avid Interplay, you might have received a 
C++ Runtime Error. This has been fixed.

➤ Previously, sequences with imported TIFF files might not have checked in and out of 
Interplay properly. You might have seen an “Unsupported pixel format” error. This has been 
fixed. 
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➤ Previously, you might have received the error message: "Sequence refers to non-existent 
tracks in clip" when you try to play a sequence that has been updated in Interplay by Pro 
Tools. This occured when the original sequence’s timecode did not match the Pro Tools 
sequence timecode. This has been fixed.

➤ Previously, speckles might have appeared on HD compressed video during playback. This 
has been fixed.

➤ Previously, you might have been unable to transcode 720p 50 to 1080p 25. This has been 
fixed. 

➤ Previously, you might have received a “Video Overrun” error when capturing 720p or 1080p 
with more than 2 AES/EBU audio tracks. This has been fixed. 

➤ Previously, it might have taken a long time for the editing application to log on to Interplay if 
a full text search on the Interplay database was running at the same time. This has been 
fixed. 

➤ Previously, if you transferred a sequence with a long name to AirSpace, the sequence would 
fail to transfer with a “requested function is not implemented” message. A more accurate 
message of “Sequence name exceeds 63 characters” now appears.

Fixed in v1.8.1

The following has been fixed in this release:

➤ A permission problem that might have occurred depending on how you set up your Avid 
Interplay user database has been fixed. For more information, see the Avid Interplay 
Readme. This change only affects editors in an Avid Interplay environment.

Avid Interplay Support

The Windows version of the editing application has been qualified in an Avid Interplay™ 
1.2.1 environment. 

Changed in v1.8

Avid Interplay Support

This editing application has been qualified in an Avid Interplay™ 1.2 environment.
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VC-1 Resolution

This release of the editing application includes support for editing and playback of MXF 
media encoded using the VC-1 resolution and codec. VC-1 was initially developed by 
Microsoft® and has been standardized as SMPTE 421-M. Avid Interplay does not support 
VC-1 media.

(Windows) To use the VC-1 resolutions, you must have Windows Media Player 11 installed 
on your system.

The VC-1 options appear in the Media Creation settings for Render and 
Mixdown & Transcode. These options also appear in the AAF Export settings when setting 
the “Transcode Video To” option.

With this release of the editing application, depending on the Project type and edit rate, you 
can fast copy import, playback, transcode, and render VC-1 resolutions. You must first 
export your sequence as a Windows Media File in order to perform a fast copy import into 
the editing application.

The following limitations apply to this release of VC-1:

• Macintosh: The VC-1 codec is only available on Intel-based systems and is limited to 
playback only.

• The VC-1 codec is only available for Windows media. If exporting to QuickTime you 
must export to a QuickTime-supported codec or transcode your sequence prior to 
exporting.

• AAF or OMF embedded exports of VC-1 are not allowed. Linked media is supported.

The following table shows the VC-1 capabilities with this release.

Editor VC-1 Capabilities  

Project 
Edit 
Rate

Resolution 
Name

Max Bit 
Rate

Stored 
Raster Size 
(WxHxFields) Playback Transcode

Fast 
Copy 
Import Render

NTSC 29.97 VC1-APL0 768KBit 352x240x1 Y Y N Y

VC1-APL1 10MBit 720x240x2 Y Y Y Y

VC1-APL2 20Mbit 720x240x2 Y Y Y Y

24 VC1-APL0 768KBit 352x240x1 Y Y Y Y

VC1-APL1 10MBit 720x480x1 Y Y Y Y

23.976 VC1-APL0 768KBit 352x240x1 Y Y Y Y
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VC1-APL1 10MBit 720x480x1 Y Y Y Y

PAL 25i VC1-APL0 768KBit 352x288x1 Y Y N Y

VC1-APL1 10MBit 720x288x2 Y Y Y Y

VC1-APL2 20Mbit 720x288x2 Y Y Y Y

25p VC1-APL0 768KBit 352x288x1 Y Y Y Y

VC1-APL1 10Mbit 720x576x1 Y Y Y Y

1080i 59.94 VC1-APL3 45MBbit 1920x540x2 Y Y Y Y

VC1-APL3 6MBbit 1920x540x2 N N N N

50 VC1-APL3 45MBbit 1920x540x2 Y Y Y Y

VC1-APL3 6MBbit 1920x540x2 N N N N

1080p 23.976 VC1-APL3 45MBbit 1920x1080x1 Y Y Y Y

VC1-APL3 6MBbit 1920x1080x1 N N N N

29.97 N N N N

24 VC1-APL3 45MBbit 1920x1080x1 Y Y Y Y

VC1-APL3 6MBbit 1920x1080x1 N N N N

25 VC1-APL3 45MBbit 1920x1080x1 Y Y Y Y

VC1-APL3 6MBbit 1920x1080x1 N N N N

720p 23.976 VC1-APL2 20MBbit 1280x720x1 Y Y Y Y

24 VC1-APL2 20MBbit 1280x720x1 Y Y Y Y

25 N N N N

50 VC1-APL2 20MBbit 1280x720x1 Y Y Y Y

VC1-APL3 6MBbit 1280x720x1 N N N N

59.94 VC1-APL2 20MBbit 1280x720x1 Y Y Y Y

VC1-APL3 6MBbit 1280x720x1 N N N N

Editor VC-1 Capabilities  

Project 
Edit 
Rate

Resolution 
Name

Max Bit 
Rate

Stored 
Raster Size 
(WxHxFields) Playback Transcode

Fast 
Copy 
Import Render
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Exporting as Windows Media 

Use the following procedure to export a clip or sequence as a Windows Media (VC-1) 
resolution and then import the file into your bin.

To export as VC-1:

1. Select the sequence or clips to export.

2. Select File > Export.

3. Click Options.

4. In the Export As menu, select Windows Media.

5. (Option) Select Use Marks.

When Use Marks is selected the current IN and OUT points in the selected clip or 
sequence determine starting and ending frames for the export.

6. (Option) Select Use Enabled Tracks.

When Use Enabled Tracks is selected, the system uses tracks that are enabled in the 
Timeline. To export all the tracks in the sequence, deselect this option.

7. Click Video. Select Interlaced or Progressive. 

n If you are exporting an HD interlaced sequence or clip, you must delete the audio profile in 
the Windows Media Export dialog box and export the video only. Then repeat the process, 
deleting the video and exporting the audio only.

8. Set Pixel Aspect to Square 1:1.

9. Choose Windows Media Video 9 Advanced Profile.

10. Make sure the Keyframe value is set to less than 1.00 seconds.

11. See “Windows Media Options Video Settings” in the Help for a description of the other 
video setting options.

12. Click Save.

29.97 N N N N

HDV 50i N N N N

60i N N N N

Editor VC-1 Capabilities  

Project 
Edit 
Rate

Resolution 
Name

Max Bit 
Rate

Stored 
Raster Size 
(WxHxFields) Playback Transcode

Fast 
Copy 
Import Render



 

12  

13. In the Export As dialog box, select the destination folder for the file.

14. Click Save.

15. Make sure the bin where you want to import the file is active.

16. Select Import and select the .wmv file(s) you exported.

17. Select Open and the file will appear in your active bin. The file is imported as VC-1.

Transcoding to VC1

1. Double-click Media Creation in the Settings list.

2. Click the Mixdown & Transcode tab.

3. Select the desired VC1 video resolution.

4. Select the sequence or clip you want to transcode.

5. Select Clip > Consolidate/Transcode.

6. Select Transcode. 

7. Select the appropriate options as describe in “Transcode Options” in the Help.

8. The sequence will be transcoded to the VC1 video resolution.

Rendering to VC1

1. Double-click Media Creation in the Settings list.

2. Click the Render tab.

3. Select the desired VC1 video resolution.

4. When you perform a render, the selected VC1 resolution will be used. 
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Fixed in v1.8

The following have been fixed in this release:

➤ You might have experienced edit accuracy problems with the Panasonic D5 3700B deck. 
This has been fixed. Use the Panasonic 3700B templates supplied with this release.

➤ Previously, voice-over recordings with the Audio Punch-In tool might have resulted in 
missing voice-over. This has been fixed.

➤ When importing XDCAM, the FTPClipList ignored the Audio Track settings and always 
imported ALL available tracks. This has now been fixed.

➤ Previously, you might have received an “omfiHPDomain_INIT-FAILED” error when 
transcoding XDCAM PAL MPEG 30 to MPEG 2. This has been fixed.

➤ Previously, when performing a transcode, if the media files written to a folder exceeded 
10,000, a new folder was not created. This has been fixed. Now when the media file count 
exceeds 10,000 a new folder is created. 

➤ Previously, when you swapped a P2 card that did not contain spanned clips with another P2 
card that did not have spanned clips, you received an exception error. This has been fixed.

➤ Previously, you could change the Export to ProEncode settings during an export to 
ProEncode. This has been fixed. You cannot change the export settings during the export 
process.

➤ You might have received an “internal client” error message when trying to configure storage 
in the Interplay Administrator Tool. This has been fixed.

➤ The Center Duration value was not displaying correct film footage values for various film 
types. This has been fixed.

➤ Previously, the MM Access API garbled some international characters when setting 
attributes on clips or sequences. This has been fixed. 

➤ Previously, Script Based editing was not supported with Shared Avid Projects. This has been 
fixed.

➤ You might not have been able to create multiple Media Creation Settings in the same project. 
This has been fixed.

➤ Attempting to use previous user settings might have resulted in “User Setting Not Found” 
errors. This has been fixed.
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➤ Imported P2 clips might have appeared offline in an Interplay environment. This has been 
fixed.

Changed in v1.7.7

An issue with using JKL scrub while in Trim mode has been fixed.

Changed in v1.7.6

This editing application has been qualified in an Avid Interplay™ 1.1.6 environment.

Fixed in v1.7.6

The following have been fixed in this release:

➤ Previously, you might have received a Runtime error when loading a clip from the Interplay 
window when the Audio Mixer tool was open. This has been fixed. 

➤ Previously, restored OMF or WAV files might have been quarantined. This has been fixed.

➤ Previously, you might have received an Assertion error while using a Popup monitor while 
the Interplay window was open. This has been fixed.

Fixed in v1.7.5

A compatibility issue was fixed in this release. No user functionality was affected. This 
editing application has been qualified in an Avid Interplay™ 1.1.5 environment.

Changed in v1.7.4

The following additions or changes have been incorporated into this release of the editing 
application.

Avid Interplay Support

Avid has qualified the editing applications in an Avid Interplay™ 1.1.4 environment.

n Beginning with Avid Interplay 1.1.4, an editor in an Avid Interplay environment can be a regular 
User.
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QuickTime Support

Avid qualified QuickTime® 7.2 with v1.7.4 of the Symphony Nitris editing application.

Fixed in v1.7.4

The following have been fixed:

Audio

➤ Previously, audio may have been out of phase on playback and digital cut. This has been 
fixed. 

➤ HD ancillary timecode was causing HD embedded audio to disappear during playback. This 
has been fixed.

➤ If you were using desktop play delay with monitored audio or audio-only clips or sequences, 
the blue position bar might have jumped forward at the start of play. This has been fixed by 
having the system ignore the play delay for monitored audio or audio-only clips or 
sequences.

Bins

➤ You might have seen an error message when you tried to open the Bin Fast menu. This has 
been fixed.

➤ You might have seen errors when you attempted to open bins containing master clips or 
sequences with alpha clips. This has been fixed.

Capture

➤ You might have received a BuildComposition error when trying to perform a Varicam 
capture. This has been fixed. 

EDL Manager

➤ You can now open EDL Manager from within an Avid editor and select Get Current 
Sequence from EDL Manager without getting a DISK_FILE_NOT_FOUND error.

Effects

➤ If you experience a problem with the SpectraMatte effect after promoting effects or adding 
drop shadows, try the 162.50 Nvidia driver, which may alleviate the problem. However, this 
driver is not fully qualified by Avid. The NVidia driver v91.85 is the supported version for 
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this release. The 162.50 driver does not support Full Screen Play (FSP). Video level shifting 
issues have also been seen. The 162.50 driver is located in the Program Files\Avid \ Utilities 
\NVIDIA folder.

➤ You might have seen system errors relating to memory usage after using the application for 
several hours while rendering many effects and opening and closing many bins. This has 
been fixed.

➤ The memory leaks that were occurring during rendering have been fixed.

➤ Importing moving Alpha Mattes that were non-native size to the project, displayed as black. 
This has been fixed. 

Import

➤ Your system might have hung when you tried to batch import a sequence. This has been 
fixed.

➤ (Windows only) You might have experienced a system error if you tried to set the file 
location in a batch import for clips that weren’t found, particularly for clips that were created 
on a Macintosh system. This has been fixed.

Interplay

➤ Previously, if a transcode failed with an STD Exception, audio files from the clip that was 
transcoding were deleted by the Transcode provider. This has been fixed.

➤ Previously, you might have received a “Cannot Import composition” error while transcoding 
an MPEG sequence. This has been fixed.

➤ Previously, the headframe of a clip might not have appeared in the Interplay window. This 
has been fixed.

➤ After performing an audio punch-in on a channel other than channel 1, the voice-over clip 
might have appeared offline in the bin or Timeline. This has been fixed.

➤ OMF media drives might have taken a very long time to be scanned by your Media Indexer. 
This has been fixed.

➤ Previously, the editing application might crash if you tried to search in the Interplay Window 
without being logged in to Interplay. This has been fixed.

➤ A sequence with filler and a video mixdown that played back successfully in the editing 
application might have received a “Play frame error” when the sequence was loaded in 
Assist. This has been fixed.
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➤ If you created two sequences with identical tape ID names that differed only by upper and 
lower case letters (for example, footballAug07 and FOOTBALLAug07) and then sent one 
after another to the Media Stream Server, the server might have replaced the first clip with 
the second one. Clip names on the Media Stream server are not case sensitive and the server 
does not notify the transfer manager that the tape ID is already in use for another clip. When 
sending to the Media Stream Server, the transfer manager now forces all tape IDs to lower 
case. If the tape ID already exists on the server, the transfer fails and you see an error 
message that the tape ID already exists.

➤ Clips that you checked into Interplay might have had missing associations and it might not 
have been possible to delete them. This has been fixed.

➤ Improvements were made to the validation process of the Media Indexer, this should 
improve some slowdown issues that might have occurred working on your editor 
workstation and Avid Interplay. 

➤ We have fixed the issue where the Interplay database intermittently locks when logged into 
an editing application. 

➤ Previously, master clips with audio gain were checking into Interplay with no sequence 
relatives. This has been fixed.

➤ In the Interplay Login dialog box, you could enter or change the Interplay user name and 
you should not have been able to. This has been fixed.

➤ (Interplay) Exported P2 DV 25 PAL clips might have appeared with media offline when you 
tried to import them into an Avid editing application with Dynamic Relink set to Specific 
Resolution. This has been fixed.

➤ (Interplay) You might not have been able to delete certain assets from your Interplay 
database. This has been fixed.

➤ (Interplay) You might not have been able to restore rendered effects or titles from within the 
Avid editing application or from the online database (AvidWG) in Interplay Access. This has 
been fixed.

➤ Interplay Names of folders that were opened in the Interplay window and then renamed in 
another Interplay application were not reflected in the Interplay window even if you 
refreshed the window; they sometimes caused system failures. This has been fixed. After 
you refresh the window, references to the directory in the tree browser as well as opened bins 
in the Research panel should change to the new name.

➤ (Interplay) In Interplay Access, rendered effects might have added incorrect names in the 
Tape Name text box. This has been fixed.
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➤ (Interplay) If you tried to check an audio-only sequence from a 23.976/1080p or a 
23.976/720p 23 project into Interplay, the checkin might not have been successful. This has 
been fixed.

➤ (Interplay) Sending a long sequence or several short sequences to a MediaStream server 
might have caused Interplay Transfer to fail. This has been fixed.

➤ (Interplay) Previously, you might have received an “Error loading workspaces” error when 
selecting folders. This has been fixed.

➤ (Interplay) Previously, you might not have been able to delete a QT with Alpha file from a 
bin once it had been checked in. This has been fixed.

➤ (Interplay) Previously, when a sequence that contained clips that shared the same video but 
not the same audio were archived, one of the archived clips would display in the Archive 
Engine as online and the other would display as partially online. This has been fixed. Both 
clips will now display as online.

➤ (Interplay) You might have received an Access violation when trying to manipulate 
keyframes using an effects template that was Checked In and then Checked out of Interplay. 
This has been fixed.

➤ Previously, if you modified a clip in a bin and later dragged the same clip from the Interplay 
Window to the bin, you did not receive a warning dialog that the clip had been modified. 
This has been fixed.

Managing Media

➤ Media files from the current project might not have been appearing in the Media tool. This 
has been fixed.

➤ Transcoding clips of over 30 minutes to JFIF might have failed. This has been fixed.

Panasonic P2

➤ You might have received an “HTABLE_LOOPSTATE_CORRUPT” error when importing 
spanned P2 clips. This has been fixed.

➤ Imported P2 clips might not have relinked properly. This has been fixed. 

➤ Previously, you could not group P2 imported subclips by Start TC. This has been fixed.

➤ If you exported P2 clips to a device, they might have appeared in a Quarantine folder. This 
has been fixed.
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Play

➤ We have fixed some of the memory leaks that were occuring when relinking to media on 
shared storage. 

➤ HD Ancillary timecode was not working properly. White lines may have appeared in the 
video during playback. This has been fixed. 

➤ After loading a sequence that contained Nitris Alpha RLE for 1080i you might have seen an 
error message; the system allowed you to continue after you clicked OK. You should no 
longer see the error message.

Projects

➤ If you created and closed new bins in a 24p NTSC project, you might have had to turn off 
your system to get rid of an error message. This has been fixed.

Settings

➤ If you changed user profiles from within the Avid editing application Settings window, the 
profile named might have changed but the setting did not. This has been fixed. Now when 
you change user profiles, the existing profile saves and the new profile loads correctly.

Settings

➤ If you changed user profiles from within the Avid editing application Settings window, the 
profile named might have changed but the setting did not. This has been fixed. Now when 
you change user profiles, the existing profile saves and the new profile loads correctly.

Timeline

➤ Previously, if you deleted tracks when the Timecode Window was open, you might receive a 
“Track not found” error. This has been fixed. 

➤ Previously, special keyboard keys might have invoked editing application commands. For 
example, the volume increase button initiated an insert edit, the volume decrease button 
initiated a copy command, and the Mute button cleared IN marks. This has been fixed.

Titles

➤ 16-bit processing of 10-bit resolution titles (static and animated only, not rolling or 
crawling) produced artifacts around soft shadow edges. This has been fixed.
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Trim

➤ If you tried to trim or extend the end of a FrameChase subclip in a sequence, you might have 
seen a PMM_insufficient_media error message. This has been fixed.

XDCAM

➤ If you selected multiple clips or sequences in a bin, and then selected Special > Export to 
Device > device (that is, P2, XDCAM, or HDV), only the first item was exported. This has 
been fixed.

➤ On Symphony Nitris, if you tried to update a completed Frame Chase clip from Interplay 
after playing it while it was incomplete, you might have experienced an application error. 
This has been fixed.

➤ Performing a fast import might not have imported properly. This has been fixed.

Changes in 1.7.2

The following additions have been made to this release:

• Disconnected Client Mode. See “Disconnecting an Avid Editing Application from the 
Interplay Environment” on page 62.

• Added the following procedure to the Documentation. See “Adding Locators 
On-the-Fly while Playing” on page 66.

• Added the following note to the documentation in the “Selecting Output and Timecode 
Formats for 23.976p, 24p, and 25p Projects.”

All output options for PAL and NTSC are available to you. You can switch from an 
NTSC format to a PAL format and from a PAL format to an NTSC format.

• The following note has been added to the documentation:

If you mount your P2 cards as virtual drives on your Avid editing application, import 
clips from them, and then exit the editing application, you won't see the P2 drives the 
next time you open the editing application. You need to reimport the clips. For more 
information about mounting P2 drives, see "Mounting P2 Cards as Drives" in the Help 
for your editing application.

• NVidia Driver Update to v91.85. See “Checking the NVIDIA Display Driver Version” 
on page 41.

• Avid Unity MediaNetwork v5.0 compatibility. See “Shared Storage Compatibility” on 
page 26.
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Fixed in v1.7.2

The following have been fixed in this release of the editing application.

➤ The issue causing a “Filesystem busy, retrying (deleting old bin)” and then a “binSave: error 
deleting old bin file” message when attempting to save a project, no longer exists. The 
Bin_name.avb file displayed in the Bin tab of the Project window was red and the bin file 
could not be deleted. 

➤ Previously, long captures of MPEG50 and DV50 may have resulted in video overruns. This 
has been fixed.

➤ Previously, MPEG2 transcoded resolutions may not have played back successfully. This has 
been fixed.

➤ If you made your Media Creation settings a site setting, opened a new project, and then 
closed it, you might have experienced Access Violation errors followed by a 
“DOMAIN_COPYIN_FAILED” message. This has been fixed.

➤ If you attempted a digital cut of HD material that originated in SD or the reverse, you might 
have been prompted to transcode even though it was not necessary. This has been fixed.

➤ Previously, the editing application allowed you to add Auto Gain keyframes to master clips 
in the Source side timeline. This resulted in an “Assertion failed” error. This has been fixed. 

➤ You might not have been able to use the DV 25 QuickTime® codec to export a 
720x480-sized composition from Adobe® After Effects®. This has been fixed.

➤ At the end of a transcoded clip, you might have seen a corrupt frame. This has been fixed.

➤ You might have been forced to quit the editing application if you tried to unmount a 
workspace while on the timeline. This has been fixed.

➤ A “MainThreadBus” error might have occurred when lifting a clip from a complex sequence 
after adjusting Automation Gain. This has been fixed.

➤ An Assertion error might have occurred when exporting a master clip with audio as OMF_1. 
This has been fixed.

➤ If you saved a bin while a Locator comment field was active, a “MainThread Bus” or 
“Runtime” error might have occurred. This has been fixed.

➤ Stepping into HD progressive titles or Matte Keys might have caused Assertion failures. 
This has been fixed. 
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➤ Group clips did not ScriptSync™ if a black clip was selected in the group. This has been 
fixed. 

➤ An ”Exception: MSM: No OFFLINE Media found” error might have occurred when 
attempting to link to XDCAM™ media. This has been fixed. 

➤ Previously, if a P2 drive was connected after launching the editor, the P2 drives did not 
appear when selecting Import P2 > Clip to Bin > Browse For Folder. This has been fixed. 

➤ LTC output was not adjusting properly for Audio Punchin preroll. This has been fixed. 

➤ (FilmScribe) TabbedLists or WebLists were not initially generated if you chose an audio 
channel. This has been fixed. 

➤ Previously, playback of multi-layered, high definition, progressive sequences sometimes 
resulted in an "Exception" error, which has been fixed.

➤ Output as RGB did not appear properly in Adobe After Effects . This has been fixed. 

➤ Previously, if you deleted the audio from a file, then tried to delete the video, you only had 
the choice to delete the master clip. This has been fixed. 

➤ If you tried to send media from a local drive (such as your C drive) to playback, you might 
have seen a fatal error message. This has been fixed.

➤ You might have seen a white video line with Plasma Wipe effects in HD interlaced projects 
because the effects were being created in SD and then resized. This has been fixed.

➤ Effects templates saved in bins might not have seemed to have a logical sort method when 
they displayed in the Effects Palette. Effect templates in bins now display as alphabetically 
sorted in the Effect Palette and in the Quick Transitions menu.

➤ If you played (in Full Quality mode) progressive HD media after an SD clip in an SD 
project, you might have seen a green bar and strobing in the image. This has been fixed.

➤ Previously, you might have received Exception errors when arming the video track in the 
Capture tool while attempting to capture in a 16mm PAL 24p Film Rate project. This has 
been fixed.

➤ The editing application might not have rendered AudioSuite™ effects to a workspace. This 
has been fixed. 

➤ You might have seen a “Runtime” error when lifting a clip containing an Advanced 
Keyframe effect while the Effect Editor was open. This has been fixed. 
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➤ You might have seen an “Assertion” error when performing an XDCAM SD high-resolution 
batch import. This has been fixed.

➤ Previously, you might not have been able to capture audio in a 16mm PAL 24P video 
project. This has been fixed.

➤ If you tried to do an audio mixdown of a single audio track, you might have seen an Access 
Violation error and the system might have frozen. This has been fixed.

➤ With some of the previous NVIDIA drivers, if you created a Marquee title and tried to save 
it, you might have seen a “Serious Error” message. This has been fixed with the latest 
NVIDIA drivers, which you must install manually. See “Checking the NVIDIA Display 
Driver Version” on page 41.

➤ If you used uncompressed SD material in an HD project, you might have seen corruption on 
line 21. This has been fixed.

➤ The Video Input tool and Video Output tool are now available from the Tools Menu.

➤ Occasionally, access violations occurred when trying to Post to Web This has been fixed.

➤ Choosing Undo (Ctrl + Z) after performing an “Update Bin from Interplay” operation 
caused the application to crash. This has been fixed.

➤ (Interplay) Previously, transcoded media did not show up online unless you restarted the 
editing application. This has been fixed. 

➤ (Interplay) Previously, imported M2T files did not check into the Unchecked In Avid Assets 
folder. This has been fixed.

➤ (Interplay) If you selected Bin > Update Bin from Interplay and then closed the dialog box 
by clicking the close button (the red X) without selecting any options, the bin might have 
updated anyway and any changes you made were lost. This has been fixed.

➤ (Interplay) In the Service Configuration window of the Avid Interplay Administrator, you 
can now log in without a password if a password was not set. 

➤ (Interplay) Previously, you might not have been able to delete media in a bin when working 
with 720p 23.976 35mm media. This has been fixed.

➤ (Interplay) When you captured a master clip at 24 NTSC or 23.976 NTSC and checked in 
the clip and then checked the clip out onto another system, the clip would be 30 fps and 
would not load into the source monitor. This has been fixed.
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➤ You can now mount a new tape in an Ikegami® NLTEK drive and have the Media Indexer 
recognize it, and the Manual Storage Scan command in the Avid editing application now 
points to the correct folder on the drive. 

New Features for v1.7

The following table lists the new features and where you can find additional information on 
the feature.

New Features  

Feature Description More Info

Avid DNxHD 36

Avid DNxHD 45

Avid editing applications now support the 
Avid DNxHD 36 and Avid DNxHD 45 
resolutions. 

See “Resolution 
Specifications: HD” in 
the Help.

Compressed Audio Use dynamic relink to link the low-resolution 
media to the high-resolution source media 
stored on the media network.

See “Dynamic Relink 
Settings” in the Help.

Lan Browsing 100Base T to ISIS You can now view media with a 100Base-T 
Connection to Avid Unity ISIS.

See “Viewing Media with 
a 100Base-T Connection 
to Avid Unity ISIS” in the 
Help.

720p/50 Support Avid editing applications now support the 
720p/50 format.

See “Resolution 
Specifications: HD” in 
the Help.

Sony® XDCAM Workflow 
Improvements

You can now export media to an XDCAM 
device.

See “Exporting Media to 
XDCAM Devices” in the 
Help.

Panasonic® P2 Workflow 
Improvements

You can now copy your P2 card to a 
FireWire® Drive or network drive, import 
clips and media directory from the P2 card, or 
write your sequence back to the P2 card.

See “Workflow for 
Editing with P2 Media” 
in the Help.
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Script-Based Editing Updates Script-Based editing is a new feature for the 
NewsCutter.

The following feature updates are new for all 
editing applications:

• The ability to select all text and takes. 

• The ability to double-click any line in a 
take to select the take and load it into a 
monitor.

• The ability to specify the text encoding of 
the script. 

See “Script-Based 
Editing” in the Help.

ScriptSync™ ScriptSync™ uses phonetic-indexing 
technology from Nexidia™ to analyze the 
audio portion of a clip and match it to lines of 
the script text.

See “Marking with 
ScriptSync” in the Help.

AudioSuite plug-ins The editing applications now include the 
Time Shift Audio Plug-In.

See “Time Shift 
AudioSuite Plug-In” in 
the Help.

Scrolling Timeline You can have the Timeline scroll over the 
position indicator while you play a sequence.

See “Setting the Scroll 
Option for the Timeline” 
in the Help.

Advanced Keyframe Improvements Allows you to adjust your view of advanced 
keyframe graphs.

See “Adjusting Advanced 
Keyframe Graphs”in the 
Help.

Frame Chase Capture The media becomes available for viewing and 
editing from any applications in the 
workgroup while the capture is still in 
progress

See “Frame Chase 
Capture” in the Help.

MXF vs. OMF default media. In previous releases, the default media type in 
the Media Creation settings was set to OMF. 
The default media type is now set to MXF. 

See “Media Creation 
Settings: Media Type 
Tab” in the Help.

New Features (Continued)  

Feature Description More Info
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Avid Interplay Compatibility

Avid Symphony Nitris v1.7 is supported in an Avid Interplay v1.1 workgroup environment. 
This version of Avid Symphony Nitris is not supported in an Avid Interplay v1.0 
environment. See your Avid Interplay documentation for information on Avid Interplay 
components.

Shared Storage Compatibility

The editing application has been tested in a Shared Storage environment with the following:

• Avid Unity MediaNetwork v4.1.5 and v4.2.3 

• Avid Unity MediaNetwork v5.0

• Avid Unity ISIS v1.3a 

• Avid Unity ISIS v1.4 

Changed in v1.6.6

The following were fixed:

➤ A vertical shift in the image might have appeared on the screen when you stopped playback. 
This has been fixed.

➤ Memory leaks might have occurred when you were exporting a sequence as AFE. This has 
been fixed.

➤ Playback was intermittently dropping the first few frames immediately after you selected 
Play. This has been fixed.

➤ It might have taken an unusually long time to open the Media Tool. This has been fixed.

➤ The maximum luminance levels of analog outputs was 675 mV instead of 700mV required 
by PAL. This has been fixed.

➤ User mode did not support mixed case, numbers, and punctuation restrictions for passwords. 
This has been fixed.

➤ In your editing application, if you modified a shotlist created in Assist, checked it back in, 
and then checked it out again, you might have seen an error message about importing 
conflicting subclips. This has been fixed.

➤ The editing application might not have correctly played capture video in the capture window 
when a pop-up window was open. This has been fixed.
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➤ The editing application might have displayed an “Access Violation” error when checking in 
a sequence containing rendered titles or matte keys. This has been fixed.

➤ Previously, you may have received a “DLL could not be loaded” error when performing a 
Send to Playback operation. This has been fixed.

➤  If a QuickTime export included filler between video clips, Flip Factory would fail during 
encode of the QuickTime reference movie. This has been fixed.

Fixed in v1.6.4

The following have been fixed:

➤ The previous release of the editing application was ICS (International Character Support) 
compatible but did not support French. French is now supported with this release.

➤ Multicam color-corrected sequences from Symphony Meridien might have increased 
dramatically in size when you brought them into Symphony Nitris. You can work around 
this by doing the following:

1. Start Symphony Nitris.

2. Select Tools > Console, and then type “EnableCommitMulticam” in the text box.

3. Open the bin containing the Meridien sequence.

4. Select the sequence.

5. Right-click the mouse button and select "Commit Multicam Edits."

A message box opens.

6. Click OK.

A duplicate sequence is created minus the 26-camera Multicam groupings.

7. Load this sequence.

Color Correction is promoted on only the originally selected Multicam clips; the other 
camera views per clip are removed.

➤ (Interplay) If you rendered effects in a sequence, checked the sequence into Interplay, 
deleted the rendered effects in Interplay Access, reopened the sequence in your editing 
application, and tried to rerender the effects, an error message might have opened. This has 
been fixed; you can now rerender without the error message.

➤ (Interplay) Logging in as a Windows Regular or Limited user, will no longer cause the 
Media Indexer to shut down.
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➤ If you were monitoring a sequence with a clip that referenced non-existent tracks, the error 
message that opened might not have been helpful. This has been fixed with the following 
new message: “Sequence refers to non-existent track in clip. Please turn off monitoring and 
reedit references to the following clip. You may then reenable monitoring.”

➤ Playing or performing a digital cut of PAL DV 16x9 media might have resulted in 4x3 
media. This has been fixed.

➤ Video Display Settings changes are now correctly retained as site settings.

➤ Alpha graphics are now working properly in a multirez environment.

Changes in v1.6.3

The following additions have been made for this release:

• This editor release is supported with the Avid Interplay v1.0.3 release.

• This release is ICS (International Character Support) compatible. Traditional Chinese, 
Simplified Chinese, Japanese, Italian, German, and Spanish are supported.

• (Windows) The 91.36 NVIDIA driver has been included with this version of the editing 
application in the following location: Program Files\Avid \ Utilities \NVIDIA. The 
version 91.36 driver resolves Avid Symphony Nitris memory problems, but it does not 
work with the Marquee Title Tool. If you are working with Avid Symphony Nitris and 
have memory problems, use the 91.36 driver. But, if you also use the Marquee Title 
Tool, use the version 84.26 NVIDIA driver.

Fixed in v1.6.3

The following have been fixed:

➤ If you enabled offline clip coloring for MultiRez in the Timeline, clips that were partially 
offline might have displayed incorrect colors. This has been fixed.

➤ An HDV clip that is transcoded and has common timecode with other clips, can become 
partially linked to offline media. This has been fixed. 

➤ When displaying color for mismatched resolutions in the timeline, the colors now appear 
correctly for crawling and rolling titles. 
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➤ After you removed a workspace from the primary Media Indexer with scanning in progress, 
the backup Media Indexer might have displayed an error message in the Avid Interplay 
Health Monitor, Media Indexer High Availability Group, beginning with something similar 
to the following: “Media Indexer replication error: Index: 5, Size: 4.” This has been fixed.

➤ (Interplay) Previously, if you performed a batch capture, with “Keep Existing Media” 
deselected, local cache was not updated. This has been fixed.

➤ In an Interplay environment, you might not have been able to view all the resolutions of 
imported mattes with alpha or titles in the Delete dialog box. This has been fixed.

➤ The Interplay Health Monitor might have shown the wrong number of media files in the 
Media Indexer after a unit of storage (that is, a folder on a drive, remote drive, or workspace) 
containing those files was removed from the Media Indexer. This has been fixed.

➤ Assigning a color to a sequence in a bin does not cause an access violation when checking 
the sequence into Avid Interplay.

➤ Media files copied from a WG4 workspace to a WG5 workspace are now being indexed. 
(All ediors in an Interplay environment.) 

➤ Previously, when scrubbing an IPV clip, the monitor would freeze and you would not be 
able to continue scrubbing. This has been fixed.

➤ Previously, opening the Dynamic Relink Settings dialog box a second time might display 
pulldown menu options twice and may have resulted in assertion errors. This has been fixed.

➤ The incorrect resolution text appears on an Offline Media clip after you have changed it in 
the Dynamic Relink dialog box. The clip plays fine, it just displays the incorrect resolution 
text. This has been fixed by not displaying the resolution text for Offline Media clips when 
MultiRez is enabled.

➤ Your Media Indexer service might have crashed if you removed an ISIS workspace during 
disk activity. This has been fixed.

➤ Cut lists in Avid FilmScribe™ might have been limited to two video tracks and four audio 
tracks. This has been fixed.

➤ In Avid Log Exchange (ALE), you might have encountered a “Serious Error” message when 
you tried to convert an ALE shot log to an FLX file. This has been fixed.

➤ If you changed reference from internal to blackburst, SD SDI embedded audio might have 
been output on different channels from the ones you selected for it. This has been fixed.
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➤ In an HD project with cross convert enabled (for example, a 1080i HDV project), if you 
selected Audio Project Settings > Output > HD SDI > On, the audio might not have output 
over HD SDI. This has been fixed.

➤ When you attempted an Audio Punch-In using AES/EBU audio, you might have 
encountered an Exception ADMADM_DV_CORRUPT_FRAME error and the capture 
might have failed. This has been fixed.

➤ Previously, the first frame of AVX2 effects may not have rendered properly. This has been 
fixed.

➤ Previously, stereo clips may have been out of phase on playback and digital cut. This may 
have been caused by gain changes or audio effects if they were applied to on one side of a 
stereo pair of tracks.

Workaround: Always apply changes to both sides of the stereo pair. For example, if a clip 
on A3 and A4 represent a stereo pair, when adjusting the volume of the clip in the Audio 
Mix window, adjust both A3 and A4. The level can be different for both sides, (i.e. A3 set to 
+3 db and A4 to +7 db).

➤ Digital audio should not spike when you power on the Avid DNA, start the Avid editor, or 
switch projects. 

➤ Previously, the HD client monitor video shifted to the right for 720p 50 cross convert on the 
component output. This has been fixed.

➤ If you tried to open an HDV project in Symphony Nitris, you might have experienced an 
“Assertion Failed” error and had to quit the application. This has been fixed. When you open 
a 1080i HDV project in Symphony Nitris, you now have the option to convert the project to 
the 1080i HD project type. However, the media are not converted.

➤ You might have seen duplicated fields of the last frame of video in an HD digital cut. This 
has been fixed.

➤ You might have experienced audio phase issues when you captured SD embedded audio. 
This has been fixed.

➤ When you changed a start timecode, you might have been prompted to enter film 
information, even if you were not in a film project. This has been fixed.

➤ Importing an NTSC MP4 file with audio and video sometimes resulted in audio and video 
getting out of sync. This has been fixed.

➤ When exporting a sequence as AAF, it no longer copies the audio when you have selected to 
consolidate the audio.
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➤ In an HD project with cross convert enabled (for example, a 1080i HDV project), if you 
select Audio Project Settings > Output > HD SDI > On, the audio might not have output 
over HD SDI. This has been fixed.

Fixed in v1.6.2

The following have been fixed.

c This release was a standalone editor release. DO NOT upgrade to v1.6.2 if your editing 
application is in an Avid Interplay environment. This release has not been qualified in 
an Avid Interplay environment.

➤ Previously, HD Component output shifted right when performing a crossconvert to 720p/50. 
This has been fixed.

➤ Previously, Timewarp Render Settings became disabled and reverted to Original Preference. 
This has been fixed.

➤ Previously, the AVX plugin Blur sample, and Boris sample failed to load. This has been 
fixed.

➤ Previously, you may have experienced out of phase audio on Embedded audio output. This 
has been fixed.

➤ Previously, HDV Scene Extraction might not have worked. This has been fixed.

➤ Previously, you might have received an “ADM_DIO_ERROR” when switching back to the 
Avid editing application from Avid 3D. This has been fixed.

➤ The unnecessary Pg8 tab that appeared in the Media Creation Settings dialog box has been 
removed.

➤ Long clip names might have been truncated in the bin. This has been fixed.

➤ Video Display Settings were not sticking as a site setting. This has been fixed.

➤ The 1080p/24 HD Avid DNxHD codec was missing from the Quicktime Export options list. 
This has been fixed.

➤ Previously, you could not export an OMF 2.0 sequence as audio-only if the sequence 
contained clips with MXF video and OMF audio. This has been fixed.

➤ Multigroup clips with more than one group clip did not display in the Source monitor. This 
has been fixed.
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➤ Previously, red artifacts might have appeared in the image after adjusting Master Gamma 
and Contrast. This has been fixed.

➤ Previously, audio files might have been quarantined during a scan of the media drive. This 
has been fixed.

➤ Playing a section of a sequence containing Chroma keys over a 3D Warp might have caused 
“VDMPlayConsumer” errors. This has been fixed.

➤ Multigroup clips did not convert from SD to HD project types. This has been fixed.

➤ Sound timecode was not converted properly when modifying SD 24P to 1080p/24. This has 
been fixed.

➤ Previously, modified KeyNumbers changed when opening associated bins. This has been 
fixed.

➤ Previously, if you reopened an EDL as 24fps into EDL Manager and create a sequence from 
the EDL into a 24p NTSC project and then tried to batch digitize the sequence or decompose 
the sequence and try to batch the resulting clips, you might have received an error. This has 
been fixed.

➤ Previously, the Color Correction Relationship menu was not updating properly. This has 
been fixed.

➤ Previously, when using color correction, if you clicked a bucket with a saved relationship, a 
correction was applied to a new layer with each click. This has been fixed.

➤ Previously, Alt + clicking on a bucket while parked on a clip with no Color Correction did 
not clear the bucket. This has been fixed.

➤ After applying Color Correction by dragging a template from a bin to the current monitor, 
selecting Undo listed two events instead of one. This has been fixed.

➤ The Undo list was empty after applying a saved Relationship template to a clip with an 
existing relationship. This has been fixed.

➤ When working with Color Correction, the undo feature might not have worked properly 
after applying a saved relationship from an Avid Symphony Nitris system. This has been 
fixed.
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Fixed in v1.6.1

The following have been fixed.

➤ Changes you made in the Passthrough Mix tool via the Audio Project settings dialog box 
(Input tab) might not have carried over as a site setting to a new project. This was fixed in 
part by including access to the Audio Passthrough Mix Tool in the Settings list of the Project 
window. Do the following to keep your settings changes as a site setting:

1. Select Special > Site Settings window.

2. After you make changes to the Passthrough Mix Tool, select Audio Passthrough Mix 
Tool in the Settings list and drag it to the Site Settings window.

➤ A negative amount of kerning at the bottom of a title, might have caused the title to be cut 
off. This has been fixed.

➤ Importing 24fps QuickTime movies into a 23.976 project resulted in subtracted frames. This 
has been fixed.

➤ Some sequences that contained AVX plug-ins might have caused Access Violation and out 
of memory errors. This has been fixed.

➤ Consolidating audio and video to the same drive might not have worked. This has been 
fixed.

➤ When using AVX2 Plugins and selecting the Widgets Text field might have resulted in an 
Exception error. This has been fixed.

➤ Re-editing 24p PAL Titles were not centered in a 1080p_24 project. They automatically 
defaulted to 24p NTSC frame size. This has been fixed.

➤ “VDMerr” errors might have occurred when performing a playback over a Marquee Title. 
This has been fixed.

➤ You might have heard audio distortion if the input digital audio source had different audio 
sample rates. This has been fixed.

➤ Previously, in an Avid Interplay workgroup environment, an “Exception 
DecompStream:GetStreamingLongGOPFrame code” error might have occurred when 
playing IPV media in the editor. This has been fixed.

➤ Previously, you might have received a “Caught unknown exception in Send to Workgroup” 
error when sending to workgroup from within the editing application. This has been fixed.
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➤ Previously, the dongle updater window might have displayed the wrong name for the 
product. This has been fixed.

➤ Previously, after promoting an effect, SD OMF Title media may have incorrectly displayed 
“Wrong Format”. This has been fixed.

Changes in v1.6

The following features have been included with v1.6 of the Avid Symphony Nitris editing 
application:

• Avid Interplay Compatibility

• Change to the Clear Button in the Project Window

• New Safe Color Limiter 422 Safe Parameter

Avid Interplay Compatibility

Avid Symphony Nitris v1.6 is supported in an Avid Interplay workgroup environment. 
Previous Workgroup products such as Avid Unity MediaManager are not supported with this 
release. See your Avid Interplay documentation for information on Avid Interplay 
components.

The key features related to the Avid Interplay environment are working with remote assets, 
using the Avid Interplay Window, and multi-resolution support (MultiRez):

Avid Interplay Window

The Avid Interplay Window allows you to work with clips and sequences in a shared storage 
environment without first checking out assets from a workgroup. For information on Remote 
Assets, see “Working with the Avid Interplay Window” in the Help. 

MultiRez

MultiRez is a feature that lets you create a master clip that is associated with multiple media 
files of different resolutions.For information on MultiRez, see “Using MultiRez and 
Dynamic Relink” in the Help.

Change to the Clear Button in the Project Window

The Clear button that previously appeared in the Bins tab of the Project window has been 
renamed and moved to the Info tab of the Project window. The button is now the Clear Bin 
Memory Button. See “Managing Bins and Memory” in the Help.
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New Safe Color Limiter 422 Safe Parameter

The 422 Safe parameter controls how the effect handles chroma sub-sampling when limiting 
colors.

When 422 Safe is not selected (the default value), effect processing is fast. However, 
depending on the image, a small number of transient pixel values might exceed your safe 
color ranges.

When 422 Safe is selected, effect processing is slower, but every pixel in every frame is 
guaranteed to be within your safe color ranges.

422 Safe therefore offers a choice between performance and guaranteed accuracy. In many 
situations, you can leave 422 Safe turned off. If you know that every pixel throughout your 
material must be guaranteed safe, turn 422 Safe on. Alternatively, you can leave 422 Safe 
turned off while you edit and adjust effects, then turn it on before you render or output your 
finished sequence to guarantee that every pixel in your output is color safe.

Fixed in v1.6

Note the following fixes.

➤ Previously, you might have received an error when capturing S or M resolutions. This has 
been fixed.

➤ The Interplay Media Indexer does not support P2 files created by a Panasonic SPC700 
camera that uses a firmware version earlier than December 2005. To prevent this limitation, 
update the camera firmware.

➤ Previously, MetaSync log files could not be created by non-administrator users. This has 
been fixed.

➤ Adjusting softness to a Luma key was not working. This has been fixed.

➤ Previously, editing 4x3 SD titles in HD shifted all graphics to the right. This has been fixed.

➤ Previously, Access violations occurred when changing drives in the Audio Punch-in Tool, 
after grouping drives in the Capture Tool. This has been fixed.

➤ Loading a non-group clip into the Source pop-up monitor (in Group Clip mode) didn’t turn 
off Split mode. This has been fixed.

➤ Previously, Ink Duration and AuxInk Duration were calculated to be 1 frame shorter than 
they should be. This has been fixed.
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➤ Previously, the Console command to enable HD ancillary data might not work correctly. 
This has been fixed.

➤ Previously, you might experience “Access Violation” errors when launching MediaLog. This 
has been fixed.

➤ Previously, applying an Image Resize effect and promoting to 3D might have affected video 
levels. This has been fixed.

➤ Previously, ganged sequences might not update in the source monitor when scrubbing in the 
Timeline. This has been fixed.

➤ Previously, trimming back-to-back Paint Effects on filler might hang the application. This 
has been fixed.

➤ Previously, Dupe Detection might reset to 0. This has been fixed.

Fixed in Version 1.5.3

➤ Previously, you might have experienced problems when using the editing application with 
the Japanese OS. This has been fixed.

➤ Previously, the application might have taken 15 seconds to launch. This has been fixed.

New Features in Version 1.5

The following features are new in Version 1.5:

• Send To DigiDelivery: This feature allows you to export a sequence directly to 
DigiDelivery®, the file-exchange service from Avid Digidesign®. See “Send To 
DigiDelivery” in the Help.

• Exporting an AAF file: Additional AAF Export options have been added. See 
“Exporting as an OMF or AAF File” and “Guidelines for Exporting AAF Files to 
Pro Tools” in the Help.

• Delete Dialog Box Changes: The Delete dialog box has changed. See “Deleting Bin 
Items” in the Help.

• Punch-In for Remote Play and Capture: This feature allows you to perform a Remote 
Punch-In. See “Remote Play, Capture, and Punch-In” in the Help.

• Changes to Default Location of Avid Projects: The default location of the Avid 
Projects folder has changed to use the security provided by your system’s user login. 
See “Using the Avid Projects and the Avid Users Folders” in the Help.
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• New Setting for LTC Output: To enable LTC output through the Nitris hardware, you 
need to select a setting in the General Settings dialog box. See “Using LTC Timecode 
for Output” on page 58.

• Boris Continuum Complete: Boris Continuum Complete AVX 4 has been qualified for 
use with this version of Symphony Nitris.

Symphony Nitris v1.5 has been qualified to work with NVIDIA® driver 84.26. For this 
driver, select “Multi-display compatibility mode” as the hardware acceleration setting. See 
“Configuring the NVIDIA Video Graphics Board” on page 40.

Fixed in Version 1.5
Capture (Fixed)

➤ Running the Capture tool in passthrough mode for an extended period no longer causes the 
application to run out of memory and close.

Color Correction (Fixed)

➤ If you group clips and then apply a Source relationship correction to any of the clips, you 
can subsequently remove the correction.

➤ In 8-bit SD sequences, adding an effect to a color corrected segment does not result in a hue 
shift. This problem affected segments with the Color Correction effect or relationship color 
corrections.

Editing (Fixed)

➤ You can copy material with the film mask effect to the Source monitor (Alt+C) without 
receiving an error message. 

Effects (Fixed)

➤ If you enable Dual Split in the effect editor, the left part of the viewer does not appear black.

Export (Fixed)

➤ You can correctly export a sequence with mixed resolutions as a QuickTime® movie using 
the Same as Source option and then import the movie.

Film (Fixed)

➤ You can mix gauges in a 3-perf project with the correct key number count. 
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Titles (Fixed)

➤ When opening a Marquee® document containing a crawling title, if the width of the 
Marquee project resolution is different from the width of the editing application’s project 
resolution, a message gives you the choice of automatically adjusting the crawling title to 
match the editing application’s format or creating an animated title.

➤ Using Marquee Autotitler with titles containing textures works correctly.

➤ You can correctly create a title in a PAL 24p or 25i project and save the titles as DV 25. 

Hardware and Software Requirements

The following section describes the hardware and software requirements for your system. 
For the most up-to-date information, go to www.avid.com/products/symphonynitris.

System Configuration

Symphony Nitris systems are shipped with Hewlett-Packard® Workstation xw8200, xw8400 
or xw9300.

Conversion kits are available for HP® Workstation xw8000 and HP Workstation xw8200 
systems running Avid DS Nitris. Contact your Avid representative.

QuickTime Support

Avid has tested and approved the use of Apple QuickTime® version 7.3. You must install 
QuickTime from the Apple web site. This is not supplied by Avid. Avid does not recommend 
you update to a later version at this time.

Avid recommends that you install Apple QuickTime before you install the Avid editing 
application. This ensures that the Avid editing application installs the Avid QuickTime 
codecs in the applicable QuickTime folder. If QuickTime is not installed first, the editing 
application installs the codecs in the Windows® System 32 folder. 

You can download QuickTime from www.apple.com\quicktime.

After you start Symphony Nitris, the application notifies you if QuickTime is not detected 
on your system.

http://www.apple.com/quicktime
http://www.avid.com/products/symphonynitris
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Windows Media Format Runtime Libraries

The Avid editing application requires you to have the latest Windows Media™ Format 
runtime libraries that ship with Windows Media Player 10. If you do not have Windows 
Media Player 10, access the download at www.microsoft.com.

n Windows Media export compatibility is subject to Microsoft® Windows Media updates.

Completing Your System Setup
To complete your system setup:

1. Read this ReadMe file completely. If you are updating from Symphony Nitris v1.0.x, 
read “Updating the Application Software” on page 40.

2. Connect your keyboard, mouse, and monitors. Then plug in and turn on your system. 
Cancel any wizards that appear.

3. Connect, format, and stripe your media drives, if necessary. See “Formatting and 
Striping Media Drives” on page 69.

4. Complete the installation instructions on the back of the Avid Nitris poster that was 
shipped with your Avid Nitris system.

5. Install the software, as described in “Installing the Application Software” on page 39.

6. Install the NVIDIA® driver, if necessary. See “Configuring the NVIDIA Video Graphics 
Board” on page 40.

7. Adjust your monitors. See “Setting Screen Resolution and Refresh Rate” on page 44. 

8. See Using the Avid Nitris on the CD-ROM supplied with your Avid Nitris hardware for 
instructions on connecting cables and devices to your system. Some of the connections 
allow you to control a video deck, use faders and mixers, and add storage to your 
system.

9. Install any additional drivers. See “Installing Software Drivers” on page 71.

10. Start your application. See “Starting the Application” on page 45.

Installing the Application Software

For all Avid editing applications, you must log in as an Administrator, install the application, 
and initially launch the application as an Administrator. You may then subsequently run the 
Avid editing application as a Regular User. 

http://www.microsoft.com/en/us/default.aspx
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To install the application software:

t Insert the application CD-ROM and follow the on-screen instructions. At the end of the 
process, restart your computer.

n Avid recommends that you install Apple QuickTime before you install the Avid editing 
application. See “QuickTime Support” on page 38.

Updating the Application Software

If you are updating from Symphony Nitris v1.0.x, uninstall the existing application and 
install the new version.

To update the application software:

1. Insert the application DVD.

2. On the opening screen, select Install Products.

3. On the next screen, select Avid Symphony Nitris.

A message box asks if you want to uninstall Avid Symphony Nitris.

4. Click Yes.

A confirmation box asks if you want to uninstall the application.

5. Click Yes.

6. Click Finish.

The installation program removes the application.

7. On the Welcome screen, click Next.

8. Follow the on-screen instructions. 

When the installation program asks if you want to uninstall the DIO, click Yes.

When a message box tells you that the driver has not passed Windows Logo testing, 
click “Continue Anyway.”

9. At the end of the process, restart your computer.

10. Start the application.

A dialog box opens and requires you to update the Avid Nitris firmware. Select Update 
and follow the prompts carefully.

Configuring the NVIDIA Video Graphics Board

Symphony Nitris supports the following graphics cards for full 3D OpenGL® compatibility:

• NVIDIA Quadro® FX 1500 (with HP xw8200 workstations)
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• NVIDIA Quadro FX 3000 (with HP xw8000 workstations)

• NVIDIA Quadro FX 3400 or 3450 (with HP xw8200 workstations)

• NVIDIA QuadroFX3500 (with HP xw8400, xw9300)

Symphony Nitris has been qualified to work with NVIDIA driver 91.85.

n The revision of the driver that Avid supports can change at any time. You should always read 
the ReadMe file for changes prior to installing any driver. 

c Avid has tested the specific drivers for each NVIDIA board and supplies them in the 
Program Files\Avid \ Utilities \NVIDIA folder on the system. Avid recommends that 
you do not go to the NVIDIA Web site and download the latest drivers.

See the following sections for adjustments you might need to make for the NVIDIA to work 
properly with your Avid system.

Checking the NVIDIA Display Driver Version

Prior to setting up the NVIDIA card, check to make sure you have the correct display driver 
version.

c Avid has tested the specific drivers for each NVIDIA board and supplies them in the 
Program Files\Avid \ Utilities \NVIDIA folder on the system. Avid recommends that 
you do not go to the NVIDIA Web site and download the latest drivers.

To check the NVIDIA display driver version:

1. Right-click the Desktop and select Properties.

The Display Properties dialog box opens.

2. Click the Settings tab.

3. Click the Advanced button.

4. Click the Adapter tab.

5. Click Properties.

6. Click Driver Tab.

The version number is listed under the Driver Version Information. It should be 91.85.

Installing the NVIDIA Display Driver

If you do not have the proper NVIDIA driver, perform the following. 
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To install the NVIDIA display driver:

1. Double-click Program Files\Avid \ Utilities \NVIDIA\WinXP_2k(91[1].85).exe

2. Unzip the NVIDIA file to C:\NVIDIA.

3. Double-click C:\NVIDIA\WinXP_2k(91[1].85).exe file.

4. Follow the on-screen instructions and then restart your system.

Configuring the NVidia Display Settings for Multiple Display Systems

To set the Dualview mode and set acceleration on a primary monitor, do the following.

To set Dualview mode:

1. Right-click the Desktop, and select Properties. 

The Display Properties dialog box opens.

2. Click the Settings tab.

3. Click the Advanced button.

4. Click the Quadro tab.

5. In the pop-up settings window to the left of the Window, click nView Display Settings.

6. Select nView Display Modes > Dualview.

7. Click Apply, and then click OK.

To set acceleration on a primary monitor:

1. Right-click the Desktop, and select Properties.

The Display Properties dialog box opens.

2. Click the Settings tab.

3. Click the Advanced button.

4. Click the applicable Quadro tab.

n Depending on the display driver version you have, the names of the settings might be 
different.

5. In the settings window to the left of the Window, click Performance and Quality 
Settings.

6. From the Active Profile select Global Driver Settings (scroll up to select Global Driver).

7. From the Global Driver Settings, select Advanced Settings from the View drop down.

8. Scroll down and select Hardware Acceleration in the settings box.
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9. Click on the Hardware Accelerator slider at the bottom of the dialog and move the slider 
to the middle, choosing Multi-display compatibility mode.

10. Click Apply and then click OK.

Checking the OpenGL Settings

After you update your driver, when you start the editing application, make sure the OpenGL 
setting is set to your NVIDIA Display Card.

1. In the Avid editing application, open a new or existing project.

2. In the Project Window click the Settings tab.

3. Double-click Video Display.

4. In the OpenGL Hardware area, choose your NVIDIA Display Card.

Disabling the NVIDIA Driver Helper Service

The NVIDIA driver Helper Service is a background program that runs with the NVIDIA 
Driver installed. This service informs you when an update to the NVIDIA Driver is 
available. There have been instances where this service causes slow restarts and shutdown 
with the Avid DNA hardware attached. The service also can prevent the Adobe® Photoshop® 
Gamma loader from operating, which causes color correction settings not to work properly. 
If this occurs, you should disable the NVIDIA Driver Helper Service.

To disable the NVIDIA Driver Helper Service:

1. Right-click My Computer.

2. Click Manage.

3. Double-click Services and Applications.

4. Double-click Services.

5. Right-click NVidia Display Driver or NVidia Driver Helper Service.

6. Click Properties.

7. Select Startup Type > Disable.

8. Click OK.

n Every time you update or reload the driver, this service is enabled again.
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Disabling the NVIDIA Driver Helper Service

The NVIDIA driver Helper Service is a background program that runs with the NVIDIA 
Driver installed. This service informs you when an update to the NVIDIA Driver is 
available. There have been instances where this service causes slow restarts and shutdown 
with the Avid Nitris attached.  If this occurs, you should disable the NVIDIA Driver Helper 
Service.

To disable the NVIDIA Driver Helper Service:

1. Right-click My Computer.

2. Click Manage.

3. Double-click Services and Applications.

4. Double-click Services.

5. Right-click NVIDIA Display Driver or NVIDIA Driver Helper Service.

6. Click Properties.

7. Select Startup Type > Disable.

8. Click OK.

n Every time you update or reload the driver, this service is enabled again.

Setting Screen Resolution and Refresh Rate

Before starting the application, check the resolution and refresh rate for your monitors. A 
larger resolution displays more pixels and lets you view more objects in the monitors. The 
objects appear smaller at larger resolutions.

If you are using a CRT monitor with a refresh rate of 60 Hz, and you are aware of 
low-frequency interference (flicker), adjust the refresh rate to 75 Hz.

To set the screen resolution and refresh rate:

1. Right-click the desktop, and select Properties.

The Display Properties dialog box opens.

2. Click the Settings tab.

3. Click the Monitor 1 icon.

4. Set the Screen Resolution slider to 1024 x 768 pixels or higher.

Screen resolutions are limited by the system graphics board and the monitor 
specifications.

5. Click the Color Quality menu and select Highest.
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6. Set the screen refresh rate:

a. Click the Advanced button.

b. Click the Monitor tab.

c. Click the Screen Refresh pop-up menu, and select 75 Hertz.

d. Click OK.

7. Click the Monitor 2 icon and repeat steps 4 through 6.

8. Select “Extend my Windows desktop onto this monitor.”

9. Click OK.

Starting the Application

When you first start the application, a dialog box might open and require you to update the 
Avid Nitris firmware. Select Update and follow the prompts carefully.

Setting the OpenGL Mode

By default, the OpenGL setting in the editing application is set to your NVIDIA display 
card. If you are replacing your driver, check this setting.

To set the OpenGL mode:

1. In the Avid editing application, open a new or existing project.

2. In the Project Window, click the Settings tab.

3. Double-click Video Display.

4. In the OpenGL Hardware area, choose your NVIDIA display card.

5. Click OK.

Pro Tools LE Support

ProTools LE v7.4 has been qualified for interoperability with the editing application but 
cannot coexist on the same system as the editing application.

For information on supported versions of Pro Tools in an Interplay environment, see the 
Avid Interplay ReadMe.

Panasonic P2 Support

The driver version supported for this release is the following:
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(Windows) Driver version for P2 devices: v2.02

The following table lists the Panasonic P2 devices supporting write-back.

Third Party Support

Avid has qualified the following with this release of the editing application:

 Panasonic P2 Device Configurations Supporting Write-Back

Device Platform Connection

AG-HVX200P PC USB

AJ-PCD20 PC USB

PC Firewire (1394)

AJ-PCD10 PC USB

Application Version
Shipped with the following 
editing applications:

Boris™ Continuum Complete v4.2.2 and v4.2.3 Avid Media Composer
Avid NewsCutter Adrenaline
Avid Symphony Nitris

Sonic® DVDit® v6.2 Avid Media Composer
Avid NewsCutter Adrenaline
Avid Symphony Nitris
Avid NewsCutter XP
Avid Xpress Pro

Sorenson Squeeze® v4.5.5 Avid Media Composer
Avid NewsCutter Adrenaline
Avid Symphony Nitris
Avid NewsCutter XP
Avid Xpress Pro

SmartSound® V4.2 Avid Media Composer
Avid NewsCutter Adrenaline
Avid Symphony Nitris
Avid NewsCutter XP
Avid Xpress Pro
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Limitations

This section describes limitations for Symphony Nitris. General limitations are listed first, 
followed by limitations categorized by product areas.

• You cannot mix interlaced and progressive resolutions.

• Avid Studio Tools (AvidFX, Avid 3D) and Avid Pro Tools® are not qualified for use with 
Symphony Nitris v1.5.

• QuickTime audio: Symphony Nitris v1.5 does not support import or export of 96-kHz 
audio embedded in a QuickTime movie.

Audio

➤ An error message appears when you try to render the AudioSuite™ 7-Band EQ3 plug-in 
Master Clip mode. However, you can apply it and render it as a Timeline effect without 
problem.

Capture

➤ When you capture live feeds, if the tape name and capture times overlap, relink may actually 
relink to previously captured media. Avid recommends that you be careful naming live 
feeds. Change the project from which you use the live media each day and change the tape 
name for live feeds each day.

➤ Currently, when create a new project, open the Capture tool and select SDI or Composite 
video and then add a tape name, you might receive the following error: “Exception: 
AllMediaIsOMFBased() - Some media descriptors found are marked as MXF but are not 
known to be compatible with MXF domain.” This error will keep you from capturing.

Workaround: Press enter to close the error dialog, then immediately use the mouse to close 
the Capture tool. Open the Media Creations settings, then close it. Now you can successfully 
access the Capture tool.

➤ When you are capturing and using the passthrough monitor, desktop passthrough might 
cover error messages that are in the same space as the passthrough monitor, preventing you 
from being able to read them.

Workaround: Move the affected window or message box away from the Record monitor, 
put another application in front of the Avid application, and then go back to Avid to force the 
UI to refresh. 

➤ When you capture media that includes invalid frames, you might see an error message that 
the capture has been aborted and the invalid frames discarded; it asks you if you want to 
keep the clip. This message is incorrect; the invalid frames have not been discarded.
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Workaround: Click No to discard the clip, and then recapture using new marks that exclude 
the bad sections on the tape. Do not keep the clip.

➤ The first 35 frames of a sequence might be missing when you perform a digital cut after 
selecting Crash Record and Ignore Time in the Digital Cut tool.

Workaround: Add filler to the beginning of the sequence.

➤ When you deselect Enable Confidence View in the Video Display Settings dialog box and 
then open the Capture tool, the Client monitor does not display passthrough.

Workaround: Do one of the following:

t Select Enable Confidence View.

t Click the Capture button in the Capture tool.

➤ M resolution media is shifted to the right after capture. 

➤ Incoming video is always displayed in the client monitor, even when you turn off the option 
“Display incoming video in the client monitor.” 

Color Correction

➤ The Levels tab displays in the Color Correction tool might indicate that safe color limits are 
being exceeded when the Safe Color Limiter effect has been applied. The effect is correctly 
limiting the image, and the Levels tab displays are not correct.

➤ If you turn on Dual Split for color corrected clips that have certain effects applied (for 
example, Picture-in-Picture), the Dual Split corners are incorrectly positioned.

➤ Performance of sliders in the Color Correction tool and of timeline operations is slowed 
when you have waveform or vectorscope displays turned on in two of the three monitors, 
particularly when you are working with HD material, or when the safe color settings 
are selected.

Conform

➤ Clips created from imported QuickTime movies that are exported as AAF and AFE files do 
not link to media in Avid DS Nitris.

Workaround: In Avid DS Nitris, deselect “Create Linked Clips for File Sources” in the 
AAF/AFE Settings dialog box.
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➤ Conforming AvidFX: If you need to conform an effect created in an offline edit on a system 
using Avid FX, the offline editor needs to save the project with the *.red extension. The 
Symphony Nitris editor can then use Boris Red to adjust the effect. Alternatively, mix down 
or render the effect and transfer the media to the Symphony Nitris system.

Editing

➤ Viewers might not split correctly when dragging and dropping clips directly from a bin to 
the Timeline, or when using a segment mode. The second viewer appears blank, and the 
background remains on the clip image.

Workaround: Deselect the “Use Fast Scrub” option in the Display tab of the Timeline 
Settings dialog box.

➤ Relink does not relink clips if the project format does not match the clip format. For 
example, if you have unlinked SD clips in an HD project and try to relink the SD clips, 
nothing happens. The same hold true for unlinked HD clips in an SD project.

Workaround: Switch the project format in the Format tab of the project window.

➤ When copying material with the film mask effect to the Source monitor (Alt+C), you might 
get an error message: “Range specified for Dup is outside range of component.” 

EDL Manager

➤ When starting EDL Manager from the Output menu, you might see an error message saying 
there is no disk in the drive. 

Workaround: Click Cancel and the application launches.

Effects

➤ You might not be able to render a FluidBlur, FluidColorMap, or FluidMorph effect in an HD 
project if there is not enough memory available.

Workaround: Try one of the following:

• In the Bins tab of the Project window, click the Clear button, and render the Fluid effect 
(see "Managing Bins and Memory" in the Help). 

• Close all unused bins, relaunch, and render the Fluid effect.

• In the Format tab of the Project window, switch the project format to an SD format, 
render the Fluid effect, then switch back to HD. 

➤ When working with AVX effects, the following situations might lead to excessive memory 
consumption that could cause the application to hang or display errors:
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• If you repeatedly open and close bins containing sequences with third-party AVX effects 
applied.

• If you perform an Expert Render or a Render IN to OUT on a sequence that contains 
multiple third-party AVX effects.

➤ Using the eyedropper to pick a background color for a 3D warp while using the standard 
keyframe editor works only temporarily; then the background becomes solid. 

Workaround: Use the color picker or sliders to choose a color.

➤ While in Effect mode, you might not be able to scrub through blue dot effects and have the 
monitor update.

Workaround: Move the Effect Editor so that it overlaps some part of the Composer 
monitor. The monitor should now update correctly when you scrub through blue dot effects.

➤ If a sequence contains both color corrections and a Timewarp effect, you cannot access the 
Timewarp effect for editing from the Effect Editor.

Workaround: Click the Motion Effect button on the Tool palette or in the Timeline top 
toolbar to open the Motion Effect Editor and edit the Timewarp.

Export

➤ If you select Send To > DVD > DVD One Step, accept the defaults, insert a blank DVD, and 
click OK, the the Burn to DVD dialog box opens. If you select a DVD capacity size from the 
Capacity menu that does not match the actual capacity of the blank DVD you inserted, the 
application might appear to hang and the DVD does not burn.

Workaround: The capacity of your DVD must match the size you select from the Capacity 
menu.

➤ If you export a QuickTime reference movie that includes filler, and attempt to import it into 
Pro Tools, the import will fail with the message “Movie file cannot be found.” This problem 
does not occur on a Pro Tools system with Media Station.

Workaround: In the Export settings for QuickTime Reference, select “Use Network Media 
Reference” and “Add Shares for Media Drives.” 

➤ Exporting a progressive NTSC DV clip or sequence to DV Stream causes an access 
violation.

➤ Export of QuickTime or AVI movies can be very slow, especially when exporting as HD 
uncompressed media. 
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Workaround: Export as a QuickTime reference movie and encode the movie in Sorenson 
Squeeze®.

➤ Exporting Windows Media at larger than HD sizes can cause the export to fail with error 
messages.

FilmScribe

➤ Large QuickTime movies with media do not play correctly in the WebLists template. 
Individual frames from the movie are displayed.

Workaround: Use QuickTime reference movies instead. However, QuickTime reference 
movies will not play if the web folder is transferred to a server or another system.

➤ The Storyboard template is no longer supported.

➤ When starting FilmScribe from the Output menu, you might see an error message saying 
there is no disk in the drive. 

Workaround: Click Cancel and the application launches.

ICS (International Character Support)

➤ If you enter Asian characters as restriction information, the characters might appear as 
question marks when you view that restriction in another Avid application.

➤ If you capture a clip from a workspace with a French name through CaptureManager™, in 
the Avid editing application the bin heading Drive might be empty where it should list the 
French name of the workspace.

➤ If you change the font or font size of your input, amd see characters rotated 90 degrees, 
make sure you select the correct font. Do not use any font that begins with the “@” symbol.

➤ Do not create a Project using the Euro currency character (ALT 0128). The Project fails to be 
created and a “Can't Open Project” error message is displayed.

➤ Certain Asian characters might not appear in the correct order in some text boxes in your 
Avid editing application.

Import

➤ Import of QuickTime and AVI files can be very slow for HD media. To speed the process, 
use an Avid codec on the graphics workstation to render the movie in the target resolution. 
Because the Avid editing application does not need to transcode the media, import will be 
faster. 
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However, Avid HD, DV, and MPEG codecs do not support creation of movies with an alpha 
channel (RGBA), so the Avid application needs to create the channel during the import, 
resulting in an import slower than real-time. 

Workaround: If you are using an Avid DNxHD codec, you can generate the alpha channel 
and the fill as two separate movies and then import them. However, this workaround might 
not be effective if the original movies have been animated or otherwise adjusted in the 
offline edit.

Interplay Workgroup

➤ When you make a local modification to a sequence or clip in a bin and then select Update 
Bin from Interplay, a dialog box warns you, “This update includes an item that has been 
locally modified. Updating it will cause local changes to be lost.” The dialog box lists the 
following options:

• Update Anyway

• Keep Local Modifications

• Cancel

The default choice is Update Anyway, which overwrites any changes to the media that were 
made on your local system. Do not accept the default choice if you want to preserve your 
changes.

Also, if you close the dialog box by clicking the Close button (the “X” at the top of the 
dialog box) rather than selecting one of the options, the bin is updated from Interplay. 
Clicking the Close button does not cancel the update and your local changes are lost. Do not 
use the Close button to close the dialog box.

Workaround: If you want to save your local changes, click Keep Local Modifications. If 
you want to cancel the update operation, click Cancel.

➤ Batch Import of files containing Alpha. This problem occurs if you want to batch import 
files in SD and HD formats and then use Dynamic Relink to switch between the different 
formats. The problem occurs with QuickTime movies, graphics, and sequences that contain 
alpha. You can batch import the files and relink to the different formats, but if you exit and 
then restart the Avid editing application you can no longer relink to the HD format. The 
system displays an “Exception: NO Compressed Data Format found” error message.

Workaround: You cannot use Dynamic Relink with HD and SD clips that contain alpha. 
Import the HD files with alpha as individual clips. When you want to switch to HD format, 
edit the HD versions into your sequence.
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➤ If you import a graphic from your local drive into a project in an Avid editing application, 
change the original name of the clip to a name of your choice, and check that clip into a 
folder in the Interplay Window, the new name does not appear in the Interplay Window even 
when you refresh the window. You see only the original name.

➤ When you import a clip onto local storage into a local bin and then delete the clip’s media, 
you continue to see the clip in the Avid editing application Source monitor instead of the 
message “Media Offline.” If you try to play the clip, an error message box opens.

Workaround: Open another clip in the Source monitor, and then reopen the clip with the 
deleted media to correctly see the “Media Offline” message.

➤ When you incorporate clips and subclips that include locators added in Interplay Assist into 
a story in Instinct, the locators do not appear in the story. If you open the same story 
(sequence) in an Avid editing application, the locators do not appear there, either.

➤ In the Avid editing application, the Record Track monitor buttons might be deselected if the 
following happens:

1. On System 1, you create a sequence and check it into a folder in the Interplay Window.

2. On System2, you check out the sequence and load it into the Timeline.

3. On system1, you edit the sequence and check it into the Interplay folder again.

4. On system2, you refresh the Interplay window then check out the same sequence again.

Workaround: Select the Record Track buttons again.

➤ In an Avid editing application, if you have a sequence that you have not checked into the 
Interplay Window and you try to use the Transfer > Send to Workgroup command, you 
might experience an error.

Workaround: Check the sequence into the Interplay Window before you attempt to transfer 
it.

➤ When working with MultiRez, high quality audio cannot be distinguished with up-sampled 
proxy audio created with previous versions of the editor. For instance, an 8kHz proxy audio 
up-sampled to 48 kHz on import in Interplay version 1.0 will be considered as good as a real 
48 kHz high quality audio. In that case, if MultiRez is set to use 48 kHz audio, it will pick up 
the most recent file of the two.

Matchback

➤ In HD matchback projects, ink numbers and aux ink numbers count as if they are in a 24fps 
project. They do not repeat the way key numbers do to follow along with the 2:3 pulldown.
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MediaLog

➤ Exporting a bin as AFE might cause an access violation.

Workaround: Click OK. An AFE file is created in the chosen destination.

➤ If you try to batch capture clips created in MediaLog™, the capture might end with an error 
message “AudioCompAssistantForMSM.c.”

Workaround: Deselect the setting “Use the audio sample bit depth logged for each clip” in 
the Batch tab of the Capture Settings dialog box.

MultiCamera

➤ If you edit a group clip into a sequence and change one of the clips to a different camera, the 
new shot begins two frames after the edit point. This problem only occurs in MultiCamera 
mode.

Workaround: Review the sequence outside of MultiCamera mode and use Trim mode to 
make any necessary adjustments.

➤ Playing a two-way (two-camera) 1080p 23.976 sequence in MultiCamera mode might cause 
skipped frames.

Output

➤ If you have a video deck and a tri-level sync generator set to 1080p 24 fps and connected to 
your Avid Symphony Nitris system, you cannot open a 1080p 23.976 project in your Avid 
editor. You receive a VDM consumer time-out error, and no video displays in the client 
monitor. (Also, if you have a 23.976 project open, you might not be able to lock to a tri-level 
sync set to 24 fps.) This is due to a mismatch between the tri-level sync — which is required 
for output of remastered media — and the project format. This prevents you from using the 
HD Universal Mastering feature to output media remastered from a 23.976 fps format to a 
24 fps or 25 fps format.

Workaround: If you want to output media from a 23.976 project that has been remastered 
to 24 fps, do not attached a tri-level sync generator set to 24 fps until you receive a message 
asking you to connect it during your digital cut. When the digital cut completes, disconnect 
the tri-level. If you receive an error message at this point, you can still disconnect the sync 
generator.

Panasonic P2

➤ Export to P2 limitations:

• Use Marks and Use Enabled tracks are ignored on export.
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• All Audio must be PCM 16b/48K. 

• All audio tracks will be exported, although P2 devices either support 2 or 4 audio tracks. 
Therefore sequences should be built for delivery to the specified P2 playback device. 
Sequences with 6 audio tracks will have 6 audio tracks and the P2 device will only 
playback the first 2 or 4 tracks. 

➤ SD/HD Mixed sequences are not supported.

➤ 1:1 MXF media cannot be exported in both SD and HD projects. Transcode 1:1 MXF before 
exporting.

➤ The editing application does not currently support Export to P2 spanning 16GB Panasonic 
P2 cards.

➤ When you view a P2 clip that spans across multiple P2 cards in the timeline, you might be 
surprised as to what you see and don't see due to the history of mounting P2 cards on your 
current system and the P2 cards that are currently mounted. Be aware that even though 
media is offline, or you are not able to view the P2 media in the timeline, the media is not 
lost. The media appears when the card containing it is mounted.

➤ If you have P2 clips on a P2 card and you display the clips in the Media tool, you might be 
able to delete the audio and video .mxf files from the Media tool. 

➤ If you select multiple clips or sequences in a bin, and then select Special > Export to Device 
> device (that is, P2, XDCAM, or HDV), only the first item is exported.

Workaround: Export only one item at a time using the Export to Device command. 

Play

Avid Symphony Nitris cannot always play back native DVCPRO HD media without 
dropping frames. This is due to the fact that on playback, the system has to create a version 
of the media at 1920x1080 at full resolution on-the-fly. 

Workaround: Transcode the media to Avid DNxHD or uncompresssed HD for real-time 
playback.

➤ (Interplay) FrameChase in-progress clips might not playback properly on Symphony Nitris. 
The top half of the video might appear compressed and the bottom half displays the capture 
in progress slide. Once the FrameChase capture completes, and you reload the clip in the 
Interplay window the clip will playback normally.

➤ The editing application my run low on memory during playback of long 1080i/59.94 
compressed HD sequences.
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➤ LTC output is now off by default. To turn it on, open General Settings and select “Generate 
LTC On Playback.”

➤ When you are playing multi-stream sequences with non-real time effects, the video lags 
behind the audio.

Workaround: Render effects on some lower tracks.

➤ After you stop play, the frame in the edit display might show either the next frame or one of 
the previous two frames (“snapback”). The client monitor displays the correct frame.

➤ After minimizing and then maximizing the application, a VDMSFConsumer Timeout error 
might display in the Record monitor.

➤ When starting play of 8-streams of 1:1 10-bit MXF media with effects, you might see a few 
skipped frames.

Workaround: Begin play a few frames ahead of the complex material.

Titles

➤ If you re-create a rolling or crawling title in your sequence, the Scroll Position parameter 
values for the first and last keyframes will not be preserved. They will be set to the default 
values (start and end).

Workaround: Promote the title to advanced keyframe model before you re-create.

➤ 6-bit processing of 10-bit resolution titles (static and animated only, not rolling or crawling) 
can produce artifacts around soft shadow edges. This can occur when 10-bit playback mode 
is enabled or when you render using 16-bits of precision.

➤ Avid suggests that you do not attempt to edit the nested tracks of a re-created rolling or 
crawling title. If you attempt to select or edit one of these types of nested tracks, an error 
occurs. This is also the case with a re-created static title on it's alpha channel subtrack. 

➤ A sys_error occurs when you modify a title to an available drive with Render settings that 
are set to an unavailable drive (a drive that you do not have write access to). A .bak file of the 
title also appears in the bin. 

Workaround: Close the Title tool and change the Render settings to a drive that you do 
have write access to.

➤ Do not create a new rolling title in the Marquee Title Tool.

➤ Rendering simple crawling Titles in Marquee may cause problems. This is a known issue 
that might be an NVIDIA driver compatibility issue and is currently being investigated. 
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➤ Character spacing might be inaccurate in Title Tool titles using large font sizes. Some 
character pairs might appear too close together, or overlapping. In HD projects, the problem 
is only visible in the rendered title clip in the bin. In SD projects, the problem is visible 
immediately in the Title Tool. Also, once the problem has occurred in text using a large font 
size, it might persist when you create other text objects in the title at any font size.

Workaround: The best general workaround is to promote the title to Marquee. Text in 
Marquee titles does not have the same problem at large font sizes. Also, if you do not need 
your final text to use a large font size, avoid converting it to a large font size at any point in 
your workflow, or retype it as a new text object at a smaller size if increasing the font size 
causes the problem.

➤ In HD Title Tool titles, underlines or graphic objects in large text boxes such as long rolls 
might be mispositioned relative to text objects. In particular, if you use the Line tool in the 
classic Title tool to underline parts of the text in a long text roll, the positioning of the lines 
might shift when the title is saved. When you view the title in your editing application, you 
might not be able to see the underlines, or they might be offset incorrectly from the text, 
especially toward the end of the roll.

Workaround: Use multiple small text boxes within the roll, rather than one large text box. 
For example, create each piece of text that requires an underline as a separate text box.

➤ You do not need to change the Marquee title format in normal workflows. In most normal 
workflows, the title format in Marquee automatically matches the project format in your 
Avid editing application. If you change the title format in Marquee so that it does not match 
the project format in your editing application, you might see artifacts around the edges of 
some title objects.

One situation in which you might need to change the Marquee title format occurs when you 
are creating a title by opening an existing .mqp file. If the .mqp file’s format does not match 
the project format in your Avid editing application, you should change the title’s format to 
match the project format in your editing application. For more information on changing the 
title format, see “Changing Title Formats” in the Marquee Help.

➤ You can import an animation into Marquee as an OMF 1 or OMF 2 file. You cannot import 
AVI or QuickTime files.

Trim

➤ Trim viewers are black if you attempt to trim a Timewarp effect.

Workaround: Select the “Render on the Fly” option in the Features tab of the Trim Settings 
dialog box.
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XDCAM 

Importing XDCAM Files

➤ When you import XDCAM files, be aware that Avid does not support the batch import 
workflow when you are working in the following Sony XDCAM camera modes: Picture 
Cache Record Mode, Interval Record Mode, or VFR (Variable Frame Rate) Mode 
(UCC/OCC - Undercrank/Overcrank). An error message appears which informs you that the 
video is not supported. However, the High-Rez versions of these clips can be imported. 
Their timecode values, however, will be inaccurate. The Avid editor appends its own generic 
timecode to clips recorded in any of the previously mentioned modes. 

➤ When you export XDCAM media to disk, it will not include embedded timecode in this 
release.

➤ XDCAM proxy media might not export to a QuickTime reference movie successfully. 

If you export as a regular QuickTime movie, MPEG 4, or as Windows Media 9, the export is 
successful. Or, you can transcode the proxy sequence to DV 25 or MPEG-IMX and then 
export as QuickTime reference.

Workaround: Import the whole XDCamHD clip and then transcode it.

➤ The Avid editing applications refer to XDCAM HD 25 Mbits media files as HDV 1080i 
50/60. These Dynamic Relink settings are only available in project types 1080i/59.94 HDV 
or 1080i/50 HDV.

Documentation Additions and Changes

The following sections provide information that supplements the published documentation.

Symphony Nitris Basics Guide

Using LTC Timecode for Output

The Avid Nitris hardware supports LTC (longitudinal or linear timecode) output. To enable 
LTC output, you must select an option in the General Setting dialog box.

To set LTC timecode for output:

1. In the Settings list in the Project window, double-click General.

2. Select “Generate LTC On Playback.”

3. Click OK.
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Setting the Interplay Window Display

By default, the Interplay Window display all existing media objects except source clips and 
rendered effects. To reduce crowding in the Research panel and to display only those objects 
that you need to organize your project, you can display selected media objects.

When you set the display for the Interplay Window, your changes affect only the media 
objects in the active media tab. If you want to set the display for all folders displayed as tabs 
in the Research panel, make sure no tab is selected before you set the display — for 
example, you can select the Search tab before setting the display.

To set the Interplay Window display:

1. In the Research panel, click an open media tab.

n If you want your settings to apply to all media tabs in the Research panel, either make sure 
no tab is selected or select the Search tab.

2. Select Bin > Set Interplay Window Display.

The Set Interplay Window Display dialog box opens.

3. Select the object types that you want to see. The default is master clips, subclips, and 
sequences.

4. Select “Show reference clips” to automatically display objects that are referenced by 
sequences in the Research panel, whether those clips were previously in the folder or 
not.

5. Click OK. 

The Research panel displays objects according to your specifications. For information 
on the icons used to represent the different object types, see “Object Icons in Bins” in 
the Help.

Dynamic Relink Dialog Box

The option “If no match is found” appears on both the Working Settings tab and the Target 
Settings tab. As a result, you can select one option for working settings and a different option 
for target settings. For more information, see “Using the Dynamic Relink Settings Dialog 
Box” in the Help.

Media Creation Dialog Box

The Drive Filtering & Indexing tab of the Media Creation dialog box includes a button 
labeled “Manual Storage Scan.” On a system with the Interplay Media Indexer installed, use 
this button to perform an immediate indexing of local drives by the Media Indexer. This 
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button is useful if the Auto-index option is turned off and you want to index local drives and 
folders. You can then use the Interplay Service Configuration tool to remove specific drives 
or folders, if desired.

Batch Capture Dialog Box

The option “Discard original media” now reads “Discard original local media.” This change 
clarifies that you cannot delete shared media from a local bin. For more information about 
deleting media from a local bin, see “Deleting MultiRez Clips and Media from a Local Bin” 
in the Help.

Batch Import Dialog Box

The option “Keep existing media” now reads “Keep existing local media.” This change 
clarifies that you cannot delete shared media from a local bin. For more information about 
deleting media from a local bin, see “Deleting MultiRez Clips and Media from a Local Bin” 
in the Help.

Dynamic Relink and OMF Alpha

Dynamic relink does not work with OMF media files that include an alpha channel (titles or 
graphics with alpha that are imported or created in OMF resolutions.) Clips with OMF alpha 
are unaffected when the dynamic relink settings are changed.

Quality Matching

The Help includes information on how the editing application processes options such as 
“Use Closest Media.” See “Quality Matching” in the Help.

Property Merge Dialog Box

If you have Write privileges in your Interplay environment, you can change several of the 
properties associated with assets, for example, Comments or Name. These are called 
writable properties. If you try to change a writable property that another user modified after 
you accessed the asset, the Property Merge dialog box opens.
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For example, someone else who accessed a clip in Interplay Access after you loaded the 
same clip in the Research panel might have changed the name of the clip on the server; when 
you then try to rename that clip, the Property Merge dialog box opens. The change could 
have been made in any Interplay application, including Assist, Instinct, Interplay Access, or 
the Interplay Window in an Avid editing application.

You can view the original status of the writable property, your change, and the current status 
of the property on the server, and you can choose to update the asset on the server or to 
update the asset on your system. You can update the asset on the server by merging the 
changes; you can also can create the text of the change.

To update your asset with the change from the server:

t Select Update from Server.

The asset is updated with the change from the server.

To update the server with your change:

1. Select the version of the property you want to see in the Merged Value text box:

- Original - the state of the asset before you accessed it

- Your change - this version is selected by default

- Current (on server)

n You can select any combination of the versions.

The versions appear in the Merged Value text box in the order in which you select them.

2. (Option) Edit the text in the Merged Value text box to create the change you want.

3. Select Submit to Server. The asset is updated with the text in the Merged Value text box.
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Disconnecting an Avid Editing Application from the Interplay 
Environment

This section describes the new Disconnected Client mode that allows you to work while 
disconnected from the Avid Interplay™ environment.

There are two basic cases when you might want to voluntarily disconnect an Avid editing 
application from the Interplay environment:

• If you have a laptop that you want to disconnect from the network and then use it to 
work with media on your local drives. See “Voluntarily Disconnecting from the 
Interplay Environment” on page 62

• If the Interplay Framework is not available and you want to continue working on your 
local drives. See “Using Disconnected Client Mode with Network Problems” on 
page 63.

Your system administrator might also perform a forced disconnect on your system in case of 
software installation or system update. See “Forcing Disconnected Client Mode” on 
page 64.

Voluntarily Disconnecting from the Interplay Environment

In this example, assume that you are working on a laptop; you want to disconnect the laptop 
from the Interplay environment and work using the media on your local drives.

To disconnect from the network and run an Avid editing application using local drives:

1. If the Avid editing application is running, exit the application.

2. Disconnect the network cable from the Avid editing system.

3. Disconnect the Fibre Channel cable, if you have one, from the editing system.

4. Start the Avid editing application. The system displays the following message:

You don't have access to MediaIndexer. Do you want to continue in Disconnected Client 
Mode? If you do, you won't have access to shared media drives.

5. Click Continue.

The application starts without using the Media Indexer. The application uses .pmr 
and .mdb files to track media on your local drive.

The .pmr and .mdb files are database files that standalone Avid editing applications use to 
keep track of media files. A standalone system is defined as an Avid editing system that is 
not connected to an Avid Interplay environment and does not have Avid Interplay Access or 
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the Interplay Framework software installed. The Avid editing application reads .pmr files to 
determine the location of media files to load into a monitor or into the Timeline. It uses the 
.mdb files to provide information for the relink function and to populate the Media tool.

To reconnect an Avid editing application to the Interplay environment:

1. If the Avid editing application is running, exit the application.

2. Reconnect the network cable and the Fibre Channel cable to the Avid editing system.

3. Start the Avid editing application.

The system automatically starts using the Media Indexer to index media, and you are 
reconnected to the Interplay environment. 

To ensure that the Media Indexer scans your local drives, do one of the following:

t Configure your local Media Indexer to scan your local drives.

t In the Media Creation tool, select “Automatically index local drives as they come 
online.”

n For information about ensuring that the Media Indexer scans your local drives, see the Avid 
Interplay Framework User’s Guide.

Limitations of Disconnected Client Mode

The following limitations apply to Disconnected Client mode:

• The mode cannot be used with Interplay Assist or iNews® Instinct™. Those applications 
require shared storage.

• No shared drives are available in Disconnected Client mode. This includes the 
following:

- Shared drives do not appear in media drive menus for tools such as the Capture tool, 
the Import tool, or the Media Creation tool.

- Shared drives do not display in the File > Mount menu or the File > Unmount menu.

- If Auto Login is turned on for the Interplay window, the login is disabled.

- If you attempt to manually connect to the Interplay window, the option is disabled.

Using Disconnected Client Mode with Network Problems

When the Avid editing application starts up in an Interplay environment, it uses the Interplay 
Framework Lookup Service to locate the local Media Indexer. The Lookup Service is 
usually running on a network server. If the Avid editing application cannot locate the 
Lookup Service, it cannot find the Media Indexer. 
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To continue to work in Disconnected Client mode:

1. Start the editing application. 

If the application is disconnected because it has lost access to the Media Indexer, it 
displays the following message:

You don't have access to MediaIndexer. Do you want to continue in Disconnected Client 
Mode? If you do, you won't have access to shared media drives.

2. Disconnect your network cables as described in “Voluntarily Disconnecting from the 
Interplay Environment” on page 62.

3. Click Continue to work using the media on your local drives. 

The Avid editing application uses .pmr files to keep track of the media on your local 
drives.

4. If the network problem is fixed while you are working in the Avid editing application, 
exit the application, restart the application, and reconnect your cables. 

The system now uses Media Indexer to scan and keep track of your media. Besides 
having access to shared storage again, your local Media Indexer scans your local drives 
to recognize the work you did while you were disconnected. 

5. For information about ensuring that the Media Indexer scans your local drives, see the 
Avid Interplay Framework User’s Guide.

Forcing Disconnected Client Mode

Your system administrator might need to temporarily remove your editing system from 
access to the network. This might occur if new software needs to be installed or if 
components need to be updated, for example. To force a disconnect, your administrator runs 
a script that forces disconnection from the network without physically removing your 
system. Your administrator can also reconnect your system at the appropriate time using 
another script.

In this release, it is possible to import from shared drives and and export to them in Forced 
Disconnected Client mode. Avid recommends, however, that you do not import from or 
export to shared drives when your administrator has force-disconnected your editing system. 
Avid does not support any workflow that includes importing from or exporting to shared 
drives when the system is in Forced Disconnected Client mode.

In general, if you are in Forced Disconnected Client mode and if you import or export using 
shared drives, after the import or export those drives might appear to be available for other 
purposes such as importing, capturing, playing, or deleting media, but they are not available. 
Similarly, options for shared storage might appear to be available in various settings dialog 
boxes and shared drives and media might appear in various menus, tools, and applications; 
Avid does not support use of these settings, drives, or media.
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Workaround: To remove the shared drives from your drive lists, do one of the following:

t Disconnect your network cables as described in “Voluntarily Disconnecting from the 
Interplay Environment” on page 62.

t Exit your editing application and restart it.

The following limitations describe specific instances of drives and options appearing in 
Forced Disconnected Client mode:

• In the Select Project dialog box, shared workspaces and projects are available and 
should not be.

• Shared drives and media are available in the Media tool and in the MetaSync® 
application and should not be.

• In the Interplay Server Settings dialog box, you can change the Interplay server name 
and you should not be able to.

• In the Interplay Login dialog box, you can enter or change the Interplay user name and 
you should not be able to.

• In the Capture tool, you can select the Interplay Folders option as your capture 
destination and you should not be able to.

• In the MXF Media Files tab of the Capture Settings dialog box, you can select the 
“During capture, clip is updated in Interplay” option and you should not be able to.

• In the Temporary File Directory option of the General Settings dialog box, you can type 
the name and location of a shared drive and you should not be able to.

• Shared drives and media are visible in the Hardware tool and should not be. 

• Shared drives are visible in the Import dialog box and should not be. 

• Options in the Media Services Settings dialog box are available and and should not be. 

• Options in the Transfer Settings dialog box are available and and should not be. 

• Selecting LANshare, PortServer settings, or ProEncode™ appears to be available but 
should not be. Do not select these options.

• Dynamic Relink can be enabled but that should not have been allowed. Do not enable it. 

• With sevedal of the options in the File menu, you are allowed to select a shared 
workspace as a destination but you should not be able to. Do not select a shared 
workspace in this context.

• If you select Automatic Login at Project Selection in the Interplay User Settings dialog 
box, enter Disconnected Client mode, exit the mode and the editing application, 
reconnect, and then restart the editing application, you need to log into Interplay again 
and you shouldn’t have to.
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Adding Locators On-the-Fly while Playing
1. Load a sequence or clip. See “Loading Footage” in the Help.

2. (Option) Select a specific track, using the Track Selector panel. See “Using the Track 
Selector Panel” in the Help.

3. Map the Add Locator button to a key by doing the following:

a. Open the Command Palette, click the More tab, and select Button-to-Button 
Reassigment.

b. In the Settings list of the Project window, double-click Keyboard.

c. Drag an Add Locator button to a key on the Keyboard palette.

n For more information about mapping buttons to keys, see “Mapping User-Selectable 
Buttons” in the Help.

4. Click the Play button, and every time you want to add a locator, press the key to which 
you mapped the Add Locator button. 

n You can map different Add Locator buttons to different keys to be able to add more than one 
color of locator.

To add comments to the locators:

1. Stop playing.

2. Do one of the following:

t Double-click the locator in the position bar under the monitor.

t Click the large oval on the frame in the monitor.

A Locator edit pane opens. The locator name, color, frame, and track 
information appear.

n By default, the locator name is the user name logged onto your system. You can change this 
by typing a new name in the Name text box.

3. Type your comments in the comment area of the Locator edit pane.

4. (Option) Change the color from the Color menu or change the locator name.

5. To save your information, click OK, or press the Enter key.

The information is stored with the marked frame.

The locator oval appears in the Timeline, in the position bar, and at the bottom of the 
frame in the monitor.

n You can also click the Locator icon in the Locators window to edit locator information.
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To keep the Locator edit pane from opening:

1. Select Tools > Locators.

The Locators window opens.

2. Select Disable Locators Popup from the Fast menu.

The Locator edit pane now does not open even if you double-click a locator.

Symphony Nitris Conform and Finishing Guide
• In the “Working with HD Media” chapter, a table refers to 1080i/59.94 HDV and 

1080i/50 HDV as options for modifying sequences. These options are not available in 
Symphony Nitris.

• In the “Conforming and Transferring Projects” chapter, there is a reference to the Color 
Effect that states:

“For Color effects created on Media Composer or Avid Xpress Pro, the Chroma Adjust 
parameter values might not match.”

For Color effects created on Media Composer v2.5 or later and Avid Xpress Pro v5.5 or 
later, the Chroma Adjust parameter values match those for Symphony Nitris.

Symphony Nitris Advanced Guide

References to Full Screen Playback in this guide or other documentation do not apply to 
Symphony Nitris.

HD Title Filtering

Titles created with the Title Tool or Marquee in an HD project might display undershoots 
and overshoots in the SD signal after you downconvert and output a sequence. This problem 
might also occur with imported animated graphics that contain an alpha channel (except for 
QuickTime imports). You can avoid this problem by using a console command to filter HD 
titles and imported graphics.

The HD title filter is disabled by default, and entering this command enables it. Note the 
following:

• Enter the command before creating titles or importing animated graphics. The command 
does not affect media already created.

• Using the title filter might result in a slight softening of sharp transitions between dark 
colors and light colors.
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To turn on HD title filtering:

1. Select Tools > Console.

2. Enter HDTitleFilter.

This command works as a toggle, so the filter remains on until you type the command again.

Performance with MXF 1:1

The performance of Symphony Nitris is substantially better when using MXF 1:1 video 
instead of OMF 1:1. This improved performance occurs because the video format used in 
MXF 1:1 video files is the same as the native format used by the Nitris hardware, which 
allows the system to play more streams of video and render effects faster.

Symphony Nitris Basics Guide

Extending Your Usable Address Space

The Microsoft Windows XP operating system limits every program to 2 gigabytes (GB) of 
address space. It reserves the remaining 2 gigabytes of address space for its own use. The 
operating system includes a boot-time mechanism that allows applications access to a larger 
virtual address space than was previously available. The installation program adds the 
correct information to the system’s boot.ini file. However, in some circumstances the 
installation program cannot add the information and displays a message that tells you to 
check the ReadMe file. 

The following information describes how to manually edit the boot.ini file to extend the 
address space. 

c Be very careful editing the boot.ini file. If you have any questions, check with your 
system administrator.

To manually change the usable address space:

1. Right-click My Computer and select Properties.

2. Click the Advanced tab.

3. In the Startup and Recovery section, click the Settings button.

4. From the “Write debugging information” menu, select “Kernel memory.”

5. Select “Overwrite any existing file”

6. Click OK.

7. In the Startup and Recovery section, click the Settings button.
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In the System startup section, note the default operating system selection. You will edit 
this selection later. 

8. Click the Edit button.

The boot.ini - Notepad window opens.

9. Make sure the file includes the following line, which should have been added by the 
installer:

multi(0)disk(0)rdisk(0)partition(1)\WINDOWS="Microsoft Windows XP 
Professional Avid 2.5GB" /3GB /userva=2500/fastdetect 
/noexecute=optin 

If this line does not exist, add it exactly as written.

10. Save the file and exit Notepad.

11. In the Startup and Recovery window, press OK.

12. In the System Properties window, in the Startup and Recovery section, click the Settings 
button.

13. In the System startup section, from the Default operation system menu, select 
“Microsoft Windows XP Professional Avid 2.5GB.”

14. Click OK.

15. In the Advanced tab, click OK.

16. Restart your system.

17. During the boot process, make sure to select:

Microsoft Windows XP Professional Avid 2.5GB

Formatting and Striping Media Drives

To use all the resolutions that Symphony Nitris offers, you need to create striped volumes for 
the drives contained in your Avid MediaDock™ Ultra320. 

The following table lists supported configurations. All configurations should be striped 
across two Ultra320 SCSI busses.

Supported Configurations for MediaDock Ultra320  

Configuration MediaDock Ultra320 Mode

6 drives (one enclosure, three drives on each SCSI channel), 
single striped volume

Dual-bus
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For more information on configuring the MediaDock Ultra320, see Using the Avid Nitris or 
the Avid MediaDock Ultra320 Setup and User’s Guide.

Number of Streams Supported

Information about the number of streams supported is provided in the Avid Symphony Nitris 
Striping Table.

To find the latest striping table:

1. Access the Knowledge Base at www.avid.com/onlinesupport/.

2. Type “Symphony striping table” in the Search for text box.

3. Click Search.

Creating a Partition and Formatting a Drive

To create a partition and format a drive:

1. Start your system, and log in to an account with administrative privileges.

2. Right-click the My Computer icon, and select Manage.

The Computer Management window opens.

3. Click the Disk Management folder.

n For more information on the Computer Management window, click the Help icon in the 
toolbar of the Computer Management window.

4. Make the first drive a Dynamic drive by right-clicking the disk ID section of the disk in 
the Computer Management window and selecting Upgrade to, or Create Dynamic disk, 
depending upon the status of your disk.

When you select a disk in the Computer Management window, the white section of the 
disk changes to stripes, showing that the disk has been selected. 

5. Repeat step 4 for each drive you want to stripe.

12 drives (one enclosure, six drives on each SCSI channel), 
single striped volume

Dual-bus

2 x 12 drives (two enclosures, one enclosure on each SCSI 
channel), two striped volumes (each volume must have six 
drives from each enclosure)

Single-bus

Supported Configurations for MediaDock Ultra320 (Continued)  

Configuration MediaDock Ultra320 Mode

http://www.avid.com/onlinesupport
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6. Right-click one of the Dynamic drives and select Action > Create Volume.

7. Follow the instructions in the Create Volume Wizard to finish striping the drives using 
NTFS format.

Installing Software Drivers

The Avid installation software does not automatically load the software drivers for the 
USB-to-MIDI software or Command|8® software. If they are needed, you must install the 
drivers separately. For information on connecting these devices to your system, see Using 
the Avid Nitris on the Avid Nitris CD-ROM.

The installation software does not automatically load drivers for Avid Unity clients. For 
information on configuring Avid Unity clients, see the MediaNetwork or Avid Unity ISIS 
documentation.

Installing USB-to-MIDI Drivers

You need to install USB-to-MIDI software drivers if you use one of the following devices to 
control audio gain automation on your Avid system:

• JL Cooper FaderMaster Pro™ MIDI automation controller 

• JL Cooper MCS-3000X MIDI automation controller

• Yamaha® 01V or Yamaha 01V/96 digital mixing console

These controllers are referred to as fader controllers. Avid supports the MIDIMAN™ 
MIDISPORT™ 2x2 USB-to-MIDI converter to connect the fader controller to your 
USB hub.

The Using the Avid Nitris guide, included on the documentation CD-ROM, describes how to 
connect a fader controller to your Avid system. This section describes how to install the 
driver software that recognizes your fader controller.

c To reduce traffic on the USB bus, connect the USB-to-MIDI converter only if you need 
to use the JL Cooper FaderMaster Pro, the JL Cooper MCS-3000X, or the Yamaha 
01V or Yamaha 01V/96 fader box.

To install the MIDISPORT 2x2 drivers: 

1. Ensure that the MIDISPORT 2x2 USB to MIDI converter is not connected to the 
system. When you are ready to load the drivers, you will use a USB connector to 
connect the MIDISPORT 2x2 USB-to-MIDI converter to your computer.

2. Download the latest MIDISPORT 2x2 drivers from the following Web site: 
www.m-audio.com.

http://www.m-audio.com
http://www.m-audio.com
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The system downloads a compressed, executable file.

3. Double-click the downloaded file to uncompress the driver files to a floppy disk or to a 
folder on your system.

4. Double-click the Install.txt file that is included with the downloaded files. This file 
contains the instructions for loading the drivers.

5. To initiate the driver installation, use a USB connector to connect the MIDISPORT 2x2 
USB-to-MIDI converter to the system. It is not necessary to connect the external fader to 
the MIDISPORT 2x2 device.

The system automatically detects that a new device has been connected and opens the 
Found New Hardware Wizard dialog box.

6. Follow the instructions in the Install.txt file. 

n If you uncompressed the files to a folder on your system, two drivers might appear in the list. 
You can select either one.

Installing Command|8 Drivers on a Windows System

You can use the Command|8 as a control surface for Symphony Nitris. The Windows drivers 
for the Command|8 are on the Pro Tools installer CD-ROM that ships with the Command|8. 
If you want to use the Command|8, launch the Command|8 installer located at 
/Drivers/Command8/Command8 setup.exe. For more information on using the Command|8 
with your Avid editing application, see “Using an External Fader or Controller” in the Help.

n Use of Pro Tools and Symphony Nitris on the same system is not supported.

Installing the SCSI or Fibre Channel Driver and Updating Firmware

The Avid application does not automatically load the SCSI or Fibre Channel driver or 
firmware. The ATTO 2-Gb Fibre Channel adapter boards, both optical and copper, use the 
same driver. An ATTO configuration utility is used to perform firmware updates. The 
configuration utility, driver, and firmware are installed on the hard drive along with the 
editing application.

For complete information on configuring an Avid Unity client, see the Avid Unity 
documentation.

To install the ATTO Celerity SCSI driver:

1. After installing the ATTO Celerity host adapter, access the Program 
Files/Avid/Utilitities folder.

n If the Found New Hardware dialog opens, do not use the Wizard to install the driver.
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2. Open the ATTOSCSI folder.

3. Double-click the Setup.exe file.

4. Follow the on-screen prompts.

To install the Fibre Channel adapter board and driver: 

1. Install the board according to the manufacturer’s instructions. For information on which 
slot to use, see “HP Workstation xw8200 Slot Configuration and Connections” in Using 
the Avid Nitris or in the Help.

Do not connect any drives to the ATTO Fibre Channel board.

2. Turn on the system and log in with administrator privileges. 

A Found New Hardware Wizard appears.

3. Select “Install the software automatically (Recommended)” and click Next.

When the driver is found, you get a message telling you that the drover did not pass the 
Windows logo testing.

n If the Hardware wizard cannot locate the driver, manually select the Fibre Channel driver in 
the following location: Program Files\Avid\Utilities\ATTOFC\Drivers.

4. Click Continue Anyway.

5. Click Finish.

n The Fibre Channel Hardware Wizard might come up again. If you are asked for the ATTO 
Phantom Device driver repeat this process. 

6. Restart the system.

To install the ATTO Configuration Utility:

1. Navigate to the following location:

Program Files\Avid\Utilities\ATTOFC\Utilities

2. Double-click epiconf230.exe. 

The ExpressPCI Configuration tool opens.

3. Click Next. 

The License Agreement window opens.

4. Select “I accept the terms of the License Agreement,” and then click Next.

5. Read the information in the window, and then click Next.

The Choose Install Folder window opens.

6. Accept the default, and then click Next. 
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The Pre-Installation Summary window opens.

7. Click Install. 

The configuration utility and driver are installed. This takes approximately 1 minute.

8. Click Done.

9. Restart the system.

To update the Fibre Channel adapter board firmware:

1. Shut down the system.

2. Disconnect the Fibre Channel cable from the Fibre Channel board.

3. Start the system.

4. Navigate to Start\All Programs\ExpressPCI Configuration Tool.

5. Select ExpressPCI Configuration Tool.

The ATTO ExpressPCI Configuration Tool window opens.

6. In the left pane, expand hosts to localhost. You see ExpressPCI FC 3300 or FC 3305.

7. Click ExpressPCI FC 3300 or FC 3305. 

8. In the right pane, click the Flash tab. 

The Flash options appear.

9. Click the Browse button, navigate to Program Files\Avid\Utilities\ATTOFC\Firmware
FlashBundle_xx, and then click Open.

10. Click Update.

A message box opens, instructing you to unmount all devices.

11. Click OK. 

The firmware updates. The update is finished when a message appears at the bottom of 
the ExpressPCI Configuration Tool window.

12. Close all open windows.

13. Shut down the system.

14. Connect the Fibre Channel cable to your PC.

15. Start the system.

For information on security settings for Avid Unity client systems, see “Avid Unity Client 
Configuration Notes” on page 75.
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Avid Unity Client Configuration Notes

For complete information on configuring an Avid Unity client, see the Avid Unity 
MediaNetwork or the Avid Unity ISIS documentation.

For Avid Unity ISIS clients, make sure that the transmit and receive descriptors for the IP 
address are set to 1024.

To set up the Windows Firewall for Avid Unity clients:

1. Launch the Security Center application from Start > Programs > Accessories > System 
Tools > Security Center.

2. Click Windows Firewall.

3. Click the General tab and make sure Firewall is turned ON.

4. Make sure the “Don’t allow exceptions” option is not selected.

5. Click the Exceptions tab:

For MediaNetwork clients, make sure the following items are listed and selected with a 
check mark: 

- Avid Unity MediaNetwork

- Avid Unity Connection Manager

For Avid Unity ISIS clients, make sure all “AvidUnityISIS” items are listed and 
selected.

6. For MediaNetwork Clients, click the Advanced tab and do the following:

a. In the ICMP area, click the Settings button.

b. Make sure “Allow incoming echo requests” is selected with a check mark.

c. Click OK.

7. In the Windows Firewall dialog box, click OK.

8. In the Windows Security Center window, click Automatic Updates and select “Turn off 
Automatic Updates.”

9. Click OK.

10. Close the Security Center.
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Disabling Automatic Software Updates

Avid cannot guarantee the compatibility of the Avid editing application with automatic 
updates of Windows XP or any updates to system software components. You should disable 
automatic updates.

To disable automatic software updates: 

1. Do one of the following:

t Select Start > Control Panel, and then double-click System.

t Select Start > Control Panel, and then double-click Performance and Maintenance > 
System.

2. Click the Automatic Updates tab.

3. Deselect “Keep my computer up to date.”

4. Click OK.

Additional Information

The following information is helpful when you work with your Avid system.

Goodies Folder

Avid supplies a Goodies folder located on the Symphony Nitris DVD. Access the Goodies 
folder by browsing the Symphony Nitris DVD. This folder contains programs and files you 
might find useful when trying to perform functions beyond the scope of the Symphony 
Nitris software.

c The information in the Goodies folder is provided solely for your reference and as 
suggestions for you to decide if any of these products fit into your process. Avid is not 
responsible for the manufacture, support, or sales of these products. Avid is also not 
responsible for any loss of data or time, or any other adverse results related to the use 
of these products. All risks of using such products or accessing such Web sites are 
entirely your own. The Web sites listed in the Goodies folder are not under the control 
of Avid, and Avid is not responsible for their content, any changes or updates to them, 
or the collection of any personal data or information by the operators of such Web 
sites. All information and product availability is subject to change without notice.
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Ensuring Optimum Performance

Background tasks can interrupt time-critical operations, such as capturing, playing, or 
rendering. Make sure that background tasks are not running while you are working on the 
Avid editing system.

Turn Off Simple File Sharing

c Turning off Simple File Sharing is required. If you do not do this, you might get Access 
Denied errors after moving files.

To turn off Simple File Sharing:

a. Double-click My Computer.

b. Select Tools > Folder Options > View.

c. Scroll down to the bottom of the window and deselect “Use simple file sharing 
(Recommended)”.

Optimum Performance for Windows 

The following list contains suggestions for ensuring optimum performance when working 
with the Avid editing system:

n The steps below might vary depending on if you have Windows Classic mode or Windows XP 
mode selected.

• Disable CPU throttling: 

a. Click the Start button, and select Settings > Control Panel.

b. Double-click Power Options. 

c. Select Power schemes > Always On.

• Optimize Windows for best performance:

a. Right-click My Computer and select Properties.

b. Click the Advanced Tab.

c. In the Performance section, click Settings.

d. Select “Adjust for Best Performance.”

• Disable screen savers.

• Do not enable the Windows Display setting “Show window contents while dragging.” 
This setting hinders redraw performance on the Avid editing system. Do the following:

a. Click the Start button, and select Settings > Control Panel.
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b. Double-click Display. 

c. Click the Appearance tab.

d. Click the Effects button. 

e. Deselect “Show window contents while dragging.”

• Do not leave the Console window open when you are editing. The Avid editing system 
performance slows considerably when the Console window is open.

• Do not leave a Windows Explorer window open. Windows Explorer tries to update file 
information.

• Do not leave an e-mail application open if it is set to do periodic checks for mail. 

• Do not run any application that periodically “wakes up” and performs an action (for 
example, virus scanners and disk fragment utilities).

• Do not keep media on the same partition where the application is installed. Avid 
recommends external media drives.

• Always disable system sounds:

a. Select Start > Settings > Control Panel.

b. Double-click Sounds and Audio Devices. 

c. Click the Sounds tab, and select Sound scheme > No Sounds.

d. Click OK.

• Always use small fonts with the display driver to avoid missing characters in the 
application dialog boxes. 

• After moving a drive from one system to another, you must restart your system. 
Windows does not recognize the drive until you restart the system.

• To ensure you do not accidentally delete locked items from your desktop:

a. Right-click the Recycle Bin icon on your desktop.

b. Select Properties. 

c. Click the Global tab. 

d. Select “Display delete confirmation dialog.”

e. Click OK.

• When you are advancing by single frames through the Timeline, deselect Clip > Render 
On-the-Fly to enable faster response time.

• Do not name files with special characters (/ \ : ? ” < > | *), because Windows does not 
recognize special characters in file names. Bin names are limited to 27 characters (not 
including the four characters reserved for the file name extension).
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• Do not schedule automatic backups at times when your Avid editing system might be in 
use.

• Do not run any application that includes prescheduled or automatically scheduled 
activities, such as a calendar program.

• Do not leave other applications running. Some applications, such as Microsoft Office, 
run background processes.

• Do not allow the Find Fast background process (find.exe) to run. The process tries to 
update its cache of file and folder locations. Check your Startup folder, and delete the 
file if it is there. To locate the find.exe, select Start > Search > find.exe.

a. Turn off AutoPlay for Multimedia devices. Windows XP uses an AutoPlay feature 
to automatically run programs and open files that it encounters on CD-ROMs and 
DVDs. Double-click the My Computer icon on your desktop. 

b. Right-click the CD-ROM or DVD drive you want and select Properties.

c. Click the AutoPlay tab, and select Mixed content from the pop-up menu. 

d. Select “Select an action to perform,” and then select Take no action. 

e. Click OK.

Special Notes

This section contains important information about system-level changes that affect the way 
your Avid software and hardware operate.

Antivirus Applications

Antivirus programs containing autoscanning features can interfere with the operation of the 
Avid editing application. For example, some antivirus programs can be configured to run in 
the background and scan all files for viruses whenever they are opened, copied, or moved. 
Since virus scanning is a processor-and disk-intensive activity, it can interfere with capturing 
and playing real-time effects in the Avid editing application. 

Avid recommends you do not scan all files or schedule any background tasks such as virus 
scanning when you are using your Avid editing application. 

File deletion protection utilities also consume system resources and could interfere with the 
proper operation of the Avid editing application. These utilities automatically back up any 
files that are deleted, even temporary files created and deleted by the Avid editing 
application. This consumes a large amount of disk space.
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Turn off Automatic Reboots

The Automatic Reboot option is turned on by default on some Windows XP systems. To turn 
off automatic restart:

a. Click the Start button, and select Settings > Control Panel.

b. Double-click System.

c. Click the Advanced tab.

d. Click the Settings button under Startup and Recovery.

e. Deselect Automatically restart under System failure.

f. Click OK.

Panasonic AG-DVX100 Camera

Avid recommends that you use certain device settings when using the AG-DVX100 camera 
with an Avid editor.

Device Setup 

Make sure the device is in VTR mode by toggling the button on the front of the camera. 
Adjust the following Device Menu Settings on the camera:

Recording Setup 

• REC SPEED - SP 

• 1394 TC REGEN - OFF 

• TC MODE - DF/NDF (Must match the tape in the device)

• TCG - REC RUN 

• FIRST REC TC - REGEN 

AV In/Out Setup

DV OUT - OFF 

Using the Panasonic AG-DVX100 Camera with a 24p Project

To capture an NTSC 24p project in DV, your footage needs to have been shot with advanced 
pulldown. This is currently available using the Advanced option of the Panasonic 
AG-DVX100 camera.

If you want to use 1394 deck control to capture from the Panasonic AG-DVX100 camera, set 
the menu in the device as follows:
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Menu > RECORDING SETUP > 1394 TC REGEN > OFF

Panasonic AG-DVX100 Camera Communication Error

You might lose communication with the Avid Adrenaline if you switch between the Capture 
tool and the Digital Cut tool when performing a digital cut with DV device control.

Workaround: Close each tool after you are through using it. 

If you do lose communication, quit the application, power cycle the Avid Adrenaline, then 
restart the application.

Disconnecting Devices

Do not disconnect devices while running the Avid application. Before starting the Avid 
application, make sure all your devices are connected first.

If You Need Help

If you are having trouble using your editing application:

1. Retry the action, carefully following the instructions given for that task. It is especially 
important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after 
the documentation was published.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit Avid Online Support at www.avid.com/onlinesupport/. Online support is available 
24 hours per day, 7 days per week. Search the Knowledge Base to find answers, to view 
error messages, to access troubleshooting tips, to download updates, and to read or join 
online message-board discussions.

http://www.avid.com/onlinesupport
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Copyright and Disclaimer
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, 
Inc. The software described in this document is furnished under a license agreement. You can obtain a copy of that license by 
visiting Avid's Web site at www.avid.com. The terms of that license are also available in the product in the same directory as 
the software. The software may not be reverse assembled and may be used or copied only in accordance with the terms of the 
license agreement. It is against the law to copy the software on any medium except as specifically allowed in the license 
agreement. 

Avid products or portions thereof are protected by one or more of the following United States Patents: 4,746,994; 4,970,663; 
5,045,940; 5,267,351; 5,309,528; 5,355,450; 5,396,594; 5,440,348; 5,452,378; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 
5,568,275; 5,577,190; 5,584,006; 5,640,601; 5,644,364; 5,654,737; 5,715,018; 5,724,605; 5,726,717; 5,729,673; 5,745,637; 
5,752,029; 5,754,851; 5,799,150; 5,812,216; 5,852,435; 5,584,006; 5,905,841; 5,929,836; 5,930,445; 5,946,445; 5,987,501; 
6,016,152; 6,018,337; 6,023,531; 6,058,236; 6,061,758; 6,091,778; 6,105,083; 6,118,444; 6,128,001; 6,134,607; 6,137,919; 
6,141,691; 6,198,477; 6,201,531; 6,223,211; 6,249,280; 6,269,195; 6,317,158; 6,317,515; 6,330,369; 6,351,557; 6,353,862; 
6,357,047; 6,392,710; 6,404,435; 6,407,775; 6,417,891; 6,426,778; 6,477,271; 6,489,969; 6,512,522; 6,532,043; 6,546,190; 
6,552,731; 6,553,142; 6,570,624; 6,571,255; 6,583,824; 6,618,547; 6,636,869; 6,665,450; 6,678,461; 6,687,407; 6,704,445; 
6,747,705; 6,763,134; 6,766,063; 6,791,556; 6,810,157; 6,813,622; 6,847,373; 6,871,003; 6,871,161; 6,901,211; 6,907,191; 
6,928,187; 6,933,948; 6,961,801; D392,269; D396,853; D398,912. Other patents are pending.

Copyright © 2007 Avid Technology, Inc. and its licensors. All rights reserved.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf 
of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms 
of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
888 I/O, Adrenaline, AirPlay, AirSPACE, AirSPACE HD, AirSpeed, AniMatte, AudioSuite, AudioVision, AutoSync, Avid, 
Avid DNA, Avid DNxcel, Avid DNxHD, AVIDdrive, AVIDdrive Towers, Avid Learning Excellerator, Avid Liquid, Avid Mojo, 
AvidNet, AvidNetwork, AVIDstripe, Avid Unity, Avid Xpress, AVoption, AVX, CamCutter, ChromaCurve, ChromaWheel, DAE, 
Dazzle, Deko, DekoCast, D-Fi, D-fx, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Intelligent Noise Reduction, 
DigiDrive, Digital Nonlinear Accelerator, DigiTranslator, DINR, DNxchange, D-Verb, Equinox, ExpertRender, FieldPak, 
Film Composer, FilmScribe, FluidMotion, HIIP, HyperSPACE, HyperSPACE HDCAM, IllusionFX, Image Independence, 
iNEWS, iNEWS ControlAir, Instinct, Intraframe, iS9, iS18, iS23, iS36, LaunchPad, Lightning, Lo-Fi, Magic Mask, 
make manage move | media, Marquee, Matador, Maxim, MCXpress, Media Browse, Media Composer, MediaDock, 
MediaDock Shuttle, Media Fusion, Media Illusion, MediaLog, Media Reader, Media Recorder, MEDIArray, MediaShare, 
MediaStream, Meridien, MetaSync, MissionControl, NaturalMatch, Nearchive, NetReview, NewsCutter, Nitris, OMF, 
OMF Interchange, OMM, Open Media Framework, Open Media Management, PCTV, Pinnacle MediaSuite, Pinnacle Studio, 
Pinnacle Systems, ProEncode, Pro Tools, QuietDrive, Recti-Fi, RetroLoop, rS9, rS18, Sci-Fi, Show Center, Softimage, 
Sound Designer II, SPACE, SPACEShift, SpectraGraph, SpectraMatte, SteadyGlide, Symphony, TARGA, Thunder, Trilligent, 
UnityRAID, Vari-Fi, Video Slave Driver, VideoSPACE, and Xdeck are either registered trademarks or trademarks of Avid 
Technology, Inc. in the United States and/or other countries.

Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or 
other countries. Macintosh is a trademark of Apple Computer, Inc., registered in the U.S. and other countries. QuickTime and 
the QuickTime logo are trademarks used under license from Apple Computer, Inc. The QuickTime logo is registered in the 
U.S. and other countries. All other trademarks contained herein are the property of their respective owners.
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